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1 Introduction

1.1 What Is SpamSieve?

SpamSieve is an application that filters out unsolicited mass mailings, commonly known as “spam.”
Previously, most people just ignored spam messages or created simple rules in their e-mail clients
to filter them out. In recent years and months, the spam problem has gotten worse. Today’s spam
is harder to detect, and there is more of it.

SpamSieve gives you back your inbox by bringing powerful Bayesian spam filtering to popular e-
mail clients. It learns what your spam looks like, so it can block nearly all of it. It looks at your
address book and learns what your good messages look like, so it won’t confuse them with spam.
Other spam filters get worse over time as spammers adapt to their rules; SpamSieve actually gets
better over time as you train it with more messages. SpamSieve doesn’t delete any messages—it
only marks them in your e-mail client—so you’ll never lose any mail. SpamSieve works with any
number of mail accounts, of whatever types are supported by your e-mail software (e.g. POP,
IMAP, Hotmail, AOL).

1.2 Identifying Spam

SpamSieve uses a statistical technique known as Bayesian analysis. For a more in-depth treatment
of this technique applied to spam, see this article by Paul Graham! and the papers it references.
Bayesian spam filtering is highly accurate and adapts to new types of spam messages “in the field.”

First, you train SpamSieve with examples of your good mail and your spam. When you receive a
new message, SpamSieve looks at how often its words occur in spam messages vs. good messages.
Lots of spammy words mean that the message is probably spam. However, the presence of words
that are common in your normal e-mail but rare in spam messages can tip the scale the other way.
This “fuzzy” approach allows SpamSieve to catch nearly every spam message yet produce very
few false positives. (A false positive is a good message mistakenly identified as spam. Most users
consider false positives to be much worse than false negatives—spam messages that the user has to
see.)

Because you train SpamSieve with your own mail, you have full control. If SpamSieve makes a
mistake, you can train it with the message in question so that in the future it will do better. Further,
since spammers don’t have access to the messages you trained SpamSieve with, they have no way
of knowing how to change their messages to get through. Whereas other spam filters become less
effective as spammers figure out their rules, SpamSieve becomes more effective over time because
it has a larger corpus of your messages to work from.

"http://www.paulgraham. com/spam. html
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1.3 Integration

Separate from the issue of identifying spam messages is the issue of how to prevent you from having
to deal with them. There are basically six kinds of anti-spam software for doing this:

Challenge-Response Systems

This software requires people who sends you mail to prove that they are human, and not
an automated spam-sending program. After sending you a message, they get a reply asking
them to complete a task that is easy for humans but hard for computers. Only then is the
message passed on to you. This system is a nuisance for senders, delays your reception of the
mail, and becomes impractical when sending messages to a group of people. Also, challenge
response systems cannot deal with spoofed senders or legitimate messages that are sent by
programs.

Server-Side Filters

This software runs on mail servers and often filters out spam before you ever see it. This
means that you do not have to download the spam messages that it catches. However, some
spam messages may still get through, and, unless the filter is perfect, a few legitimate messages
will not. These could be important messages, and you will never know that you lost them.

Server-Side Taggers

This variant of server-side filters does not delete possible spam messages before you download
them. Instead, you download every message and configure your e-mail client to move mes-
sages that were tagged by the filter into a separate spam folder. This eliminates the major
disadvantage of server-side filters—lost messages—however this type of filter is generally not
as accurate as the ones below, because it does not adapt to your own mail.

Client-Side Filters

This software connects to your mail server to delete spam messages before your e-mail client
can download them. This is a clunky approach: to catch all the spam messages, you have to
run the program right before your regular e-mail program checks for mail. This is difficult to
time properly if you check your mail often, and even so you may download some messages that
weren’t filtered. You will also download every good message twice. The anti-spam software
may let you see the messages that it filtered out, so that you can verify that there were no
false positives. However, you have to do this using its interface, not your e-mail program’s
(which is typically nicer). And if there was a false positive you then have to transfer it into
your e-mail program so that you can file and reply to it.

Client-Side Proxies

This is like a client-side filter except that the proxy downloads messages once and stores
them locally. The e-mail client then “downloads” the good messages from the proxy. This
addresses the timing and double-download problems of client-side filters, but interaction with
the filter is still awkward because it happens outside your e-mail client. In addition, you lose
some control over connections to the mail server and which messages are left on the server.

Client-Side Integrated
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This category includes SpamSieve and Apple Mail’s built-in spam filter. Suspected spam
messages are moved to a separate folder, which you can quickly scan at your leisure to make
sure there are no false positives. The e-mail client downloads messages directly from the mail
server, thus avoiding the problems of client-side filters and proxies. You can train the anti-
spam software to improve its accuracy from inside your e-mail client, and accuracy is higher
than with server-side filters because the anti-spam software can learn from the messages that
you receive. You can also control how the spam filter interacts with your regular mail sorting
rules.

Main Features

Powerful Bayesian spam filtering results in high accuracy and almost no false positives. It
adapts to the mail that you receive to get even better with time. Some other e-mail clients
include Bayesian filters, but SpamSieve is more accurate.

Integrates with your e-mail client for a superior user experience.

Integrates with the Mac OS X Address Book (and also Eudora and Entourage’s address
books) so that messages from friends and colleagues are never marked as spam.

Automatically maintains a blocklist so that it can instantly adapt to spam messages sent from
particular addresses, and catch 100% of them.

Automatically maintains a whitelist to guarantee that messages from particular senders or
mailing lists are never marked as spam, without cluttering your address book with these
addresses.

You can customize the whitelist and blocklist, adding sophisticated rules that match various
message headers, or the message body. The rules can match text in a variety of ways, including
using regular expressions.

Can use the Habeas Whitelist, which indicates messages that are not spam, as well as the
“ADV” subject tag indicating that a message is spam.

Many spammers encode the contents of their messages so that filters cannot see the incrimi-
nating words they contain. SpamSieve can decode and look inside these messages. Optionally
it can mark them all as spam, on the theory that legitimate senders do not try to obscure
their messages.

SpamSieve keeps track of how accurate it is, how many good and spam messages you receive,
and how these numbers change over time.

Turn off new-mail notification in your e-mail client, and let SpamSieve notify you only when
you receive non-spam messages.

The corpus window and log let you see how each spam message was caught.



1.5 Why Choose SpamSieve?

Given that e-mail clients such as Apple Mail, Entourage, and Eudora include their own integrated
spam filters, you may be wondering why you should consider SpamSieve. The answer is simple:
SpamSieve’s higher accuracy will save you time. Let’s see how the experts compare it with these
other program’s filters:

Apple Mail
NetNewsWire creator Brent Simmons recently switched? to SpamSieve:
Simply put: it catches my spam far more accurately than Mail ever did. Mail never
came close.
Entourage
Macworld’s April 2003 cover story, describing Entourage’s filter:

Poor; identified only 18 percent of spam; flagged 13 percent of legitimate mail as
spam.

Macworld later honored3 SpamSieve with a 2003 Editor’s Choice Award and named it Soft-
ware of the Year* (February 2004).

Eudora

Macworld’s review® of Eudora 6:

I found that SpamSieve was a more effective spam blocker than Eudora 6’s built-in
filters.

In addition, SpamSieve works with the free Sponsored edition of Eudora; Eudora’s own spam
filter requires the $50 Paid version of Eudora.

SpamAssassin

Daring Fireball’s John Gruber evaluated® SpamAssassin, which is installed on his ISP’s mail
server:

So far in September, SpamSieve has been 99.7 percent accurate for me. About
3300 messages total, 2000 of which were spam. I've had 10 false negatives, and zero
false positives. In fact, I haven’t had a single false positive, ever, with any of the
SpamSieve 2.0 betas.

This compares very favorably to SpamAssassin. Over the same period, SpamAs-
sassin had over 90 false negatives—all of which SpamSieve caught.

Or read what other SpamSieve users have to say’. Still not convinced? That’s OK. You can try
SpamSieve free for 30 days.

*http://inessential.com/?comments=1&postid=2764
Shttp://www.macworld.com/2003/12/news/eddys2003announce/
“http://www.macworld.com/2004/02/features/editorschoiceawards2004/
*http://www.macworld.com/2004/01/reviews/eudora6/
Shttp://daringfireball.net/2003/09/interview michael tsai
"http://c-command.com/spamsieve/testimonials
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2 Installing and Updating

2.1 Requirements

SpamSieve has been developed and tested on Mac OS X 10.2.6 and 10.3.6. It is designed to work
with the following e-mail clients:

e Apple Mail® from Mac OS X 10.2.6 and later (10.3.x recommended)

e Emailer 2.0v3%, previously available from Claris

e Entourage 20010 and later (Entourage 2004 recommended) from Microsoft

e BEudora 5.2!! and later (6.x in Sponsored or Paid mode recommended) from Qualcomm
e GyazMail'? 1.2.0 and later (1.2.4.2 recommended)

e Mailsmith 1.5!3 and later (2.1.4 recommended) from Bare Bones Software

e Outlook Express 5.0'4 and later from Microsoft

e PowerMail 4.0'% and later (5.1 recommended) from CTM Development

2.2 Updating From a Previous Version

SpamSieve will automatically read the corpus and statistics from previous versions. To update to
the latest version of SpamSieve, quit your mail program and the SpamSieve application and then
replace the old SpamSieve application file with the new one. That is, if SpamSieve is installed in
the Applications folder, drag the new SpamSieve application icon into the Applications folder
and click Replace when the Finder asks if you want to overwrite the old version. If you get an
error saying that you do not have sufficient privileges, drag the old SpamSieve to the trash and
empty it, and then drag the new one into the Applications folder.

Mailsmith users should make sure that Use SpamSieve is still checked in Mailsmith’s Spam
Handling preferences.

Shttp://www.apple.com/macosx/features/mail/

Shttp://www.fogcity.com
Ohttp://www.microsoft.com/mac/products/entourage2004/entourage2004 . aspx?pid=entourage2004
"http://www.eudora. com/email

2http://gyazsquare. com/gyazmail/

3http://www.barebones.com/products/mailsmith.html
Yhttp://www.microsoft.com/mac/otherproducts/outlookexpress/outlookexpress.aspx?pid=outlookexpress
Bhttp://www. ctmdev. com/powermailb
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2.3 Installing SpamSieve

Double-click the SpamSieve-2.2.4.dmg file to mount the SpamSieve disk image. Then drag the
SpamSieve application to your Applications folder.

‘8606 .4 Applications =

g Internet Explorer @ QuickTime Player
@- iSync @ Safari

5 iTunes @ Sherlock

»-:— Mail % fpamﬁieve

= . =5 .
&h Preview “== Stickies
o Lac |

( e yalrl s

Next, you must follow the instructions for setting up SpamSieve to use it with your e-mail client.
After setting up SpamSieve, you will need to train it with examples of your spam messages and
good messages.

2.4 Uninstalling SpamSieve

To uninstall SpamSieve, delete any rules that you created for it in your e-mail client. You can also
delete the AppleScripts and/or plug-in that you installed, and the SpamSieve application and its
data files, which are stored in:

/Users/<username>/Library/Application Support/SpamSieve
The preferences file is stored in:

/Users/<username>/Library/Preferences/com.c-command.SpamSieve.plist

11



Apple Mail
The plug-in is located at:

/Users/<username>/Library/Mail/Bundles/SpamSieve.mailbundle
The scripts are located in:
/Users/<username>/Library/Scripts/Mail Scripts/

or in:

/Users/<username>/Library/Scripts/Applications/Mail/

Emailer

The scripts are located in Emailer’s AppleScripts folder.

Entourage

The scripts are located in the Entourage Script Menu Items folder inside Microsoft User
Data.

Eudora 6

Eudora plug-ins may be controlled by selecting the Eudora icon in the Finder and choos-
ing Get Info from the File menu. In the Plug-Ins tab of the info window, you can
check or uncheck the various plug-ins to enable or disable them. So, if you want to switch
back from SpamSieve to Eudora’s filter: uncheck SpamSieve Eudora Plug-In and check
SpamWatch SpamWatch OSX.

Eudora 5

Delete the SpamSieve Eudora Helper file and also run the Uninstall Eudora Helper pro-
gram that came with SpamSieve. (To access the uninstaller, choose Show Other Scripts
from the SpamSieve menu.)

Outlook Express

The scripts are located in the Script Menu Items folder inside Microsoft User Data.

3 Using SpamSieve With Your E-Mail Client

Before you can use SpamSieve, you must give it some examples of messages you consider to be spam,
and ones which you do not. You do this by selecting some messages and then telling SpamSieve to
add them to its corpus. For the details of how to do this, find the section below that corresponds
to your e-mail client. For now, what’s important is that you will train SpamSieve with both good
messages and spam messages.

In general, the more messages you train SpamSieve with, the better its accuracy will be. A few
hundred messages are enough to get good accuracy. For best results, you should train SpamSieve

12



with between 1000 and 2000 messages, about 65% of them spam (as shown at the bottom of
the Statistics window). This mixture produces a low level of false negatives, while keeping false
positives rare or non-existent. For this reason, you should not train SpamSieve with all your good
messages, because you likely do not have enough saved spam messages to compensate. You can
delete spam messages after training SpamSieve with them; SpamSieve will remember the training
even after the messages have been deleted from the Spam folder in your e-mail client.

If SpamSieve marks a good message as spam, you should add the message to SpamSieve as a good
message. This lets SpamSieve know that it made a mistake, and also adds the message to the
corpus to improve future accuracy. Likewise, if SpamSieve marks a spam message as good, you
should add the message to SpamSieve as a spam message. If you do not correct SpamSieve when it
makes mistakes, its accuracy will deteriorate over time.

If you make a mistake and tell SpamSieve that a message is spam when it is actually good (or
vice-versa), simply correct yourself as you would correct SpamSieve. That is, if the message is
good, add the message as good; if it is spam, add it as spam. SpamSieve will “undo” the previous,
incorrect, addition to the corpus.

To improve SpamSieve’s accuracy, it is important to train it with new messages as you receive
them. If you have Auto-train with incoming mail checked in SpamSieve’s preferences, it will train
itself automatically. As a result, after training SpamSieve for the first time, you only need to train
it to correct mistakes.

3.1 Apple Mail
3.1.1 Installing on Mac OS X 10.3.x

Follow these instructions if you are using Mac OS X 10.3.x. If you have an older version of Mac
OS X, please see the next section.

Choose New from Apple Mail’s Mailbox menu, and create a new mailbox called Spam with
location On My Mac. Drag any spam messages in Mail’s Junk folder into the new Spam folder.

Go to the Junk Mail tab of Apple Mail’s Preferences window and uncheck Enable Junk
Mail filtering. This will disable Apple Mail’s junk mail filter so that it does not interfere with
SpamSieve.

Double-click the SpamSieve application and choose Install Apple Mail Plug-In and Scripts
from the SpamSieve menu. (If you are using a preferences-swapping utility such as Location X6,
you will need to do that for each location.) When you open Mail, you should see the two SpamSieve
items in the Scripts menu:

http://homepage .mac.com/locationmanager/

13
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Message Format Window

Help

Open Scripts Folder
Update Scripts Menu

SpamSieve - Change Settings
SpambSieve - Train Good ~30
SpamSieve - Train Spam

Count Messages in All Mailboxes
Crazy Message Text

Choose Preferences. .. from the Mail menu and click on Rules. Click the Add Rule button.
Change the description to SpamSieve. (The description of the rule must start with SpamSieve.)
Change the From menu to say Every Message. (Or, you can choose a more restrictive criterion,
if you want.) Then, next to Move Message, select the Spam folder you just created. The rule
should now look like:

Description: | Spambiewve
W [ any @ of the fellewing conditions are met:

" Every Meszage -'-H -

®

Perforem the following actions:

" Move Message @ to mailbox: | L7 Spam E = E

[ Cancel ) bl

and you can click OK to close it and save your changes. Please note that although the rule looks
like it will move every message to the Spam folder, because you have installed SpamSieve’s plug-in,
it will only move the spam messages.

SpamSieve will now automatically move new spam messages that you receive to a folder called
Spam. If SpamSieve is not running when you receive new messages, it will launch automatically.

To further customize SpamSieve, you can use the Change Settings command in Mail’s Scripts
menu.

3.1.2 Installing on Mac OS X 10.2.x

Follow these instructions if you are using Mac OS X 10.2.x. If you have a later version of Mac OS
X, please see the previous section.
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Choose New. .. from the Mailbox menu and create a new mailbox named Spam. Drag any spam
messages in Mail’s Junk folder into the new Spam folder.

Go to the Junk Mail submenu of the Mail menu, and choose Off. This will disable Apple Mail’s
junk mail filter so that it does not interfere with SpamSieve.

Next, locate the Script Menu.menu file in the AppleScript folder inside the Applications folder.
Script Menu.menu may look like a folder. Most Mac OS X 10.2 users already have this file installed.
Unfortunately, Apple no longer provides it as a separate download. If you do not have it, you can
update to Mac OS X 10.3 (in which Mail has a script menu built-in) or use a third-party script
menu such as FastScripts!”.

© O 6 |2 Applications o
Mame

Acrobat Reader 5.0

Addrass Book E
AlM Sample Scripts §

ADL Instant Messenger (5M)

IBER

v

| 68 T

Applescript

[
i
| 2

L_- Example Scripts
“.J Script Editor
- Seript Menu.menu

~
| r
%

Double-click Script Menu.menu; this will add a menu to the right side of the menu bar, with the
icon of a script. You only need to do this step once; Mac OS X will remember to show the menu
the next time you log in.

Double-click the SpamSieve application and choose Install Apple Mail Plug-In and Scripts
from the SpamSieve menu. (If you are using a preferences-swapping utility such as Location X'&,
you will need to do that for each location.) When you open Mail, you should see the two SpamSieve
items in the Scripts menu:

"http://www.red-sweater.com/RedSweater/FastScripts.html
¥http://homepage . mac.com/locationmanager/
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| 1 Applications

Mail Scripts

© SpambSieve - Change Settings
© SpambSieve - Train Good

B SpamSieve - Train Spam

+ Open Scripts Folder

Choose Preferences. .. from the Mail menu and click on Rules. Click the Add Rule button.
Change the description to SpamSieve. (The description of the rule must start with SpamSieve.)
Change the From menu to say Every Message. (Or, you can choose a more restrictive criterion,
if you want.) Then, next to Transfer Message, select the Spam folder you just created. The
rule should now look like:

Description: iEnamﬁu'.IE

" Every Message -4 - E

Perforem the following actions:

" Transfer Message E to mailbox: [ Spam E s E

[ Cancel ) (SO

and you can click OK to close it and save your changes. Please note that although the rule looks
like it will move every message to the Spam folder, because you have installed SpamSieve’s plug-in,
it will only move the spam messages.

SpamSieve will now automatically move new spam messages that you receive to the Spam folder.

To further customize SpamSieve, you can use the Change Settings command in Mail’s Scripts
menu.
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3.1.3 Training SpamSieve

To train SpamSieve with spam messages, select one or more of them and then choose SpamSieve
- Train Spam from the Scripts menu. The messages will be colored in gray and moved to the
Spam folder. To train SpamSieve with good messages, select one or more of them and then choose
SpamSieve - Train Good from the Scripts menu.

3.1.4 Manually Processing Messages

To manually ask SpamSieve to move messages that it thinks are spam to the Spam mailbox, select
the messages and choose Apply Rules from the Message menu.

3.1.5 Spam Message Colors

SpamSieve sets the colors of spam messages to reflect how spammy it thinks they are. If you tell
Mail to sort the Spam mailbox by color, the most spammy messages will be at the top, and the
least spammy ones at the bottom. Thus, if you are skimming the Spam mailbox for false positives,
you should spend more time examining the messages at the bottom.

Gray indicates that the message’s spam score is 97 or higher; purple indicates that it is between 85
and 96; red indicates that it is between 80 and 84; yellow indicates that it is between 75 and 79;
white indicates that it is less than 75.

The Change Settings command lets you enable or disable spam message coloring.

3.1.6 Whitelisting Previous Recipients

For added safety, you can tell Mail that people who you’ve sent mail to will never send you spam.
To do this, change the condition in the SpamSieve rule that says Every Message to Sender is
not in my Previous Recipients. Mail will then assume that such messages are good, without
showing them to SpamSieve. You might not want to do this, however, if you regularly receive
spam messages that are forged, so as to appear as though they were sent from one of your previous
correspondents.

3.2 Emailer

3.2.1 Installing

Choose Show Other Scripts from SpamSieve’s SpamSieve menu. Copy the files from the For
Emailer Users folder into Emailer’s AppleScripts folder:
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O O O Claris Emailer Files &
Marme &
¥ |£] AppleScripts
. About the AppleScript Menu
Spamsieve - Color If Spam

= )

Spamsieve - Mowve If Spam
SpamSieve - Train Good

(RS (RS (RS (RS |

Spam&ieve - Train Spam

‘h PRI

You may need to quit and re-launch Emailer in order for it to notice that you have installed the
SpamSieve AppleScripts.

If you want SpamSieve to color messages that it thinks are spam, set up a mail action in Emailer
that looks like this:

- Mail Action Entry: SpamSieve - Color Spam
Hisil askion name - [SpamSieve = Colar &H |
Criteria:z
Field: | Allmail || = T ||
MHere Chodees
Aetions :
Fun the AppleSeriph * SpamShve - Caler If Spam ™ a
|
Bafire Actions
[ Enatied [T Stop mad actsma if eriteria e met [ casr | [ sawe |

If, instead, you want SpamSieve to move suspected spam messages to a Spam folder (that it creates
automatically), set up a mail action in Emailer that looks like this:
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Fail Action Entry: SpamSieue - Mowe Spam
Pail sction name ; |SpamSieve = Hive Spam |
Criteriaz
Field: | Al mail || i T
More Chodces
Actiens -
P Uk AppleSoript " SpamSkve - Mewe IF Spam ™ =
X Enibked [ Stoe mam setiosd W eriberis we mat [ casest | [ Sawe ]

SpamSieve will now automatically color or move new spam messages that you receive, depending
on which mail action you set up. If SpamSieve is not running when you receive new messages, it
will launch automatically.

3.2.2 Training SpamSieve

To train SpamSieve with spam messages, select one or more of them and then choose SpamSieve
- Train Spam from Emailer’s Scripts menu. To train SpamSieve with good messages, select one
or more of them and then choose SpamSieve - Train Good from Emailer’s Scripts menu.

3.2.3 Manually Processing Messages

To manually ask SpamSieve to color or move messages that it thinks are spam, select the messages
and choose SpamSieve - Color If Spam or SpamSieve - Move If Spam from Emailer’s
Scripts menu.

3.3 Entourage 2004
3.3.1 Installing

Go to Entourage’s Tools menu select Junk E-mail Protection. Turn off Entourage’s junk filter
by clicking None and then OK. Then open the Mailing List Manager, also in the Tools menu,
and see if there are any items listed there. If so, you can leave them for now, but if you find that
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SpamSieve isn’t processing certain messages, you should try removing the items from the Mailing
List Manager.

Double-click the SpamSieve application and choose Preferences from the SpamSieve menu. Go
to Entourage’s Security preferences and make sure that Warn before allowing an external
application to access the address book is unchecked. Make sure that Use Entourage address
book is checked, and click the Load button.

Choose Install Entourage Scripts from the SpamSieve menu. After you quit and re-launch
Entourage, you should see three SpamSieve items in Entourage’s Scripts menu:

Tools Window Help

About This Menu...
Create Event from Message  ~E
Create Note from Message “N
Create Task from Message T
SpamSieve - Change Settings
SpamSieve - Move If Spam ~3M
SpamSieve - Train Good ~3HG
SpamSieve - Train Spam ~ 385

Now, set up a mail rule in Entourage that looks like this:

Edit Rule

Rule marme: I_S-panﬁlm - FMave If Spam |

o

Add Criterion 3 Remawe Criterion Execute | If all criteria are met “ |

[l messages 8]

. Then

E o Add Actbon o0 Rermove Action

| Run AppleScript B [ Scripr.. ) spamSieve - Move If SpamcM

|
|
| f Do ndt apaly ather rules o medddges that mest these criteéria

I Enabled (Cancel ) (ORH

To do this, choose Rules from Entourage’s Tools menu. Click on the tab corresponding to the
type of account you have (e.g. POP). If you have more than one kind of account, you will need to
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create an identical rule for each account type. Click the New button. Change the name of the
rule to SpamSieve - Move If Spam. Then click just to the left of Change status to select the
first action. Click Remove Action. Click on the menu that says Set category and select Run
AppleScript. Then click the Script... button and select the SpamSieve - Move If Spam\cmM
file. This file is stored in:

/Users/<username>/Documents/Microsoft User Data/Entourage Script Menu Items/

The rule window should now look like the above screenshot.

It is important that you create the rule exactly as shown. Do not add additional actions below the
action that runs the AppleScript. Such actions would apply to all messages (not just spam ones),
which is probably not what you want.

If you are using a POP account, then you are done. SpamSieve will move suspected spam messages
to a Junk E-mail folder.

If you are using an IMAP, Hotmail, or Exchange account, you will need to do a few more things.
First, (if necessary) create a folder in Entourage to hold your spam, called Junk E-mail. Second,
edit the SpamSieve - Move If Spam rule and uncheck Do not apply other rules.... Third,
create a second rule that looks like:

Edit Rule
Rule marme: | SpamSieve - Move Messages|
[
,* Add Criterion Remave Criterion Execute | If all criteria are met T_I
Category ) s 3 punk 5
Thekm
o Add Action R Action
Mowve message T! Spam B
"‘l"lr Lo not apply other rules to messages that meet these criferia

W Enabled ( Cancel ) 0K )

The action of the rule should be to move the messages to the Junk E-mail folder. After setting
up the rule, make sure that the SpamSieve - Move Messages rule appears directly below the
SpamSieve - Move If Spam rule in Entourage’s Rules window.

Go to SpamSieve’s Preferences window. Make sure that Use Entourage address book is
checked, and click the Load button. Finally, open Apple’s Address Book program and find the
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“Me” card. Add to this card any e-mail address from which you send e-mail. SpamSieve will use
these addresses to determine whether a message was sent by you.

SpamSieve will now automatically move new spam messages that you receive to the Junk E-mail
folder. If SpamSieve is not running when you receive new messages, it will launch automatically.

To further customize SpamSieve, you can use the Change Settings command in Entourage’s Scripts
ment.

3.3.2 Training SpamSieve

To train SpamSieve with spam messages, select one or more of them and then choose SpamSieve
- Train Spam from Entourage’s Scripts menu. To train SpamSieve with good messages, select
one or more of them and then choose SpamSieve - Train Good from Entourage’s Scripts menu.

Tools

Window Help

About This Menu...
Create Event from Message  ~E
Create Note from Message “N
Create Task from Message =T
SpamS5Sieve - Change Settings
SpamSieve - Move If Spam ~¥M
SpamSieve - Train Good ~3G
SpamSieve - Train Spam ~35

Note that due to the way Entourage’s AppleScript interface works, you may not be able to train
SpamSieve by selecting messages in custom mail views. Instead, select the messages in their actual
folders. Also, the training commands do not move IMAP messages to/from the spam folder.

Make sure that you correct SpamSieve’s mistakes by using the commands in the Scripts menu—do
not click the underlined blue text to indicate that a message is not spam.

3.3.3 Manually Processing Messages

To manually ask SpamSieve to move messages that it thinks are spam to the Junk E-mail folder,
select the messages and choose Apple Rule > All Rules from Entourage’s Message menu.
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3.4 Entourage v.X

3.4.1 Installing

Go to Entourage’s Tools menu select Junk Mail Filter. Make sure the Junk Mail Filter is
disabled because it interferes with SpamSieve. Then open the Mailing List Manager, also in the
Tools menu, and see if there are any items listed there. If so, you can leave them for now, but if
you find that SpamSieve isn’t processing certain messages, you should try removing the items from

the Mailing List Manager.

Double-click the SpamSieve application and choose Install Entourage Scripts from the Spam-
Sieve menu. After you quit and re-launch Entourage, you should see three SpamSieve items in

Entourage’s Scripts menu:

Tools

Window Help

About This Menu...
Create Event from Message
Create Note from Message
Create Task from Message
SpamSieve - Change Settings
SpamSieve - Move If Spam
SpamSieve - Train Good
SpamSieve - Train Spam

Now, set up a mail rule in Entourage that looks like this:

Edit Rule

Rl marme: lipanﬁlm - Have If Spam |

-

f
Add Criterion 3 Remawe Criterion Execute | if all criteria are mset

[ Al messages o]

. Then

E o~ Add Actan g Rermowve Actian

| Run AppleScript B [ seript.. ) spamSieve - Move If SpamcmM

|
|
| f Do il apdly ather fulés to mdedddiged hat mest theds crilérid

I Enabled ( Cancel ) 0K

23



To do this, choose Rules from Entourage’s Tools menu. Click on the tab corresponding to the
type of account you have (e.g. POP). If you have more than one kind of account, you will need to
create a rule for each account type. Click the New button. Type a name for your rule. Then click
just to the left of Change status to select the first action. Click Remove Action. Click on the
menu that says Set category and select Run AppleScript. Then click the Script. .. button and
select the SpamSieve - Move If Spam\cmM file. This file is stored in:

/Users/<username>/Documents/Microsoft User Data/Entourage Script Menu Items/

The rule window should now look like the above screenshot. This will make SpamSieve move
suspected spam messages to a Junk E-mail folder.

It is important that you create the rule exactly as shown. Do not add additional actions below the
action that runs the AppleScript. Such actions would apply to all messages (not just spam ones),
which is probably not what you want. To customize what Entourage does when SpamSieve finds a
spam message, you need to edit the AppleScript rather than the rule.

Go to SpamSieve’s Preferences window. Make sure that Use Entourage address book is
checked, and click the Load button. Finally, open Apple’s Address Book program and find the
“Me” card. Add to this card any e-mail address from which you send e-mail. SpamSieve will use
these addresses to determine whether a message was sent by you.

SpamSieve will now automatically move new spam messages that you receive to a folder called Junk
E-mail. If SpamSieve is not running when you receive new messages, it will launch automatically.

To further customize SpamSieve, you can use the Change Settings command in Entourage’s Scripts
mentu.

3.4.2 Training SpamSieve

To train SpamSieve with spam messages, select one or more of them and then choose SpamSieve
- Train Spam from Entourage’s Scripts menu. To train SpamSieve with good messages, select
one or more of them and then choose SpamSieve - Train Good from Entourage’s Scripts menu.
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Tools Window Help

About This Menu...
Create Event from Message ~E
Create Note from Message “N
Create Task from Message 2T
SpamSieve - Change Settings
SpamSieve - Move If Spam ~#M
SpamSieve - Train Good ~38G
SpamSieve - Train Spam ~385

Note that due to the way Entourage’s AppleScript interface works, you may not be able to train
SpamSieve by selecting messages in custom mail views. Instead, select the messages in their actual
folders. Also, the training commands do not move IMAP messages to/from the spam folder.

Make sure that you correct SpamSieve’s mistakes by using the commands in the Scripts menu—do
not click the underlined blue text to indicate that a message is not spam.

3.4.3 Manually Processing Messages

To manually ask SpamSieve to move messages that it thinks are spam to the Junk E-mail folder,
select the messages and choose SpamSieve - Move If Spam from Entourage’s Scripts menu.

3.4.4 IMAP Accounts

Entourage v.X does not support moving IMAP (or Hotmail or Exchange) messages via AppleScript.
Thus, if you have one of these types of accounts, the spam messages will not be moved to your
Junk E-mail folder. The best solution is to update to Entourage 2004, which does not have this
limitation. If you do not wish to do this, here are some possible workarounds:

e If you do not require IMAP, you can try creating a POP account in Entourage and re-
entering your account information. Many IMAP accounts also work via POP, and this will
allow SpamSieve to move the messages that it thinks are spam.

e Create an Entourage rule that moves messages that SpamSieve has marked as junk into
another folder. After receiving mail, manually apply this rule to the messages in your IMAP
account.

e Make a custom view of your IMAP account that looks for messages that are not junk. In this
way, you can view your good messages without being distracted by the spam ones.
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3.4.5 Advanced Rules

Once an Entourage rule runs an AppleScript or moves a message, it cannot apply any more rules
to that message. This limitation means that extra steps are necessary to integrate SpamSieve into
a complex set of Entourage rules. The easiest solution is to update to Entourage 2004, which is
more flexible about how it handles AppleScript rules. If you do not wish to do this, here are some
possible workarounds:

e One option is to order your rules so that Entourage applies the SpamSieve rule after all your
other rules. You can change the order of the rules by choosing Rules from Entourage’s Tools
menu and dragging the rules in the list to change their order. With this approach, you can
filter your good messages into folders however you want. Any mail that is not moved into
another folder will remain in your inbox. Then, the SpamSieve rule will either mark the
spams as junk or move them to a Junk E-mail folder. The disadvantage to this approach is
that SpamSieve cannot catch any spams among the messages that were moved by your other
rules.

e Another option is to add the Run AppleScript action to each rule that moves messages.
For instance, suppose you have a rule that moves all the messages from your Work Account
account into a Work folder. You could set up the rule as shown below.

Now, messages sent to that account will be moved to the Work folder. Spam messages sent
to that account will be moved to the Junk E-mail folder. You can add the SpamSieve
AppleScript action to every rule that moves messages and also to a “catch-all” rule that
applies to messages that aren’t moved. Then SpamSieve will be able to filter all the messages
that you receive.

Edit Rule

Rl marme: | Fove To Wark &nd Run SpamsSiews

if

5 Add Criterion ’ Execute | If all criteria are mat T!
Account B (s 58 | work Account (Michael) )
Then

= Add Action

Mowve message _=] .'I'I'l'.'lri. E’

Run AppleScnp Tl " Ceript.. ) SpamSieve - Move [f Spam' crmbd

v

E Enabled { Cancel Y @
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3.5 Eudora 6
3.5.1 Installing

If you are using Eudora 5.2 or Eudora 6 Lite, please see the Eudora 5.2 section.

Double-click the SpamSieve application and choose Install Eudora Plug-In from the SpamSieve
menu. SpamSieve will install its plug-in, disable other junk mail plug-ins (which would conflict with
SpamSieve), and reveal the Eudora application file for you.

Select the Eudora application file and choose Get Info from the Finder’s File menu. Expand the
Plug-ins pane and click Add.... Check the Esoteric Settings plug-in to enable it. Make sure
that SpamWatch OSX and SpamHeaders OSX are unchecked. You can now close the info
window and launch Eudora.

;S0 Eudora Info
P GCeneral:

= MName & Extension:

P Preview:

B Memory:

b Languages:

¥ Plug-ins:

-

E Eudora Icons 6.0

W EspoOsX 0
[ Esoteric Settings 6.0 |

il '

Emailer 2.0v3 Importer (X)

[ Add. .. :I [ Remmre...jl

b Ownership & Permissions:

b Comments:
T —

When you start up Eudora, you should see SpamSieve listed in the About Message Plug-ins. ..
window that is accessible from the Eudora menu. Please note that the version number displayed
in this window is the version of the SpamSieve Eudora Plug-In; it will not be the same as the
version number of the SpamSieve application.

Choose Preferences from the Eudora menu, scroll down to the Junk Extras settings panel
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(which is at the very bottom), and check Always enable Junk/Not Junk menu items. Next,
select the Junk Mail pane and make sure that Hold junk in Junk mailbox is checked. If you
are using IMAP, make sure that Run junk scoring plugins on this IMAP account is checked
in the IMAP settings pane.

Now Eudora will use SpamSieve to filter all incoming messages. It will move the spam messages to
the Junk mailbox. This happens before Eudora runs any incoming message filters that you have
set up.

Normally, Eudora will launch the SpamSieve application when new messages arrive or when you
train SpamSieve from inside Eudora. However, on some machines, it will not launch SpamSieve
automatically. In this case, you must manually open the SpamSieve application when you want
Fudora to filter spam messages.

3.5.2 Training SpamSieve

To train SpamSieve with spam messages, select one or more of them and then choose Junk from
Eudora’s Message menu. To train SpamSieve with good messages, select one or more of them and
then choose Not Junk from Fudora’s Message menu.

3.5.3 Setting Options

Fudora applies SpamSieve to all incoming messages. The Junk Mail area of Eudora’s preferences
lets you customize how Eudora interacts with SpamSieve. Note that the Junk Threshold slider
will have no effect because SpamSieve always considers messages with scores of 50 or above to be
spam. Thus, you should set Eudora’s junk threshold to 50 and use the slider in the Advanced tab
of SpamSieve’s preferences if you need to adjust its sensitivity.

Other settings in the Junk Mail pane do affect SpamSieve. For instance, if you check Mail isn’t
junk if the sender is in an address book, then Eudora will not pass those messages along to
SpamSieve; it will assume that they are good. Note that Eudora always considers your address to
be in its address book, even though it may not be explicitly listed there. Thus, if you receive spam
that is forged so that it appears to be sent from your own address, you must uncheck Mail isn’t
junk if the sender is in an address book in order for SpamSieve to catch it. (To still have
SpamSieve whitelist your address book, you can export!? the Eudora address book to vCard and
then import it into the Mac OS X Address Book).

The Junk Extras area of Eudora’s preferences lets you control some additional settings, such as
whether junk messages are removed from the mail server.

9http://homepage .mac. com/aamann/Eudora_vCard_Export.html
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3.5.4 Updating Eudora

Re-installing the Eudora application or updating it to a newer version may have the side effect of
disabling SpamSieve. To ensure that SpamSieve will still filter your mail, you should set up Eudora
for SpamSieve after each time you run the Eudora installer.

3.5.5 Installing the Plug-In Manually

If the Install Eudora Plug-In command doesn’t work, you can install the plug-in manually as
follows:

1. Go to the SpamSieve menu and choose Show Other Scripts.

2. In the Finder window that opens, hold down the Apple key and press Up Arrow. Now
you should see a window containing the file SpamSieve Eudora Plug-In.

3. In a separate window, locate the Eudora application, select it, and choose Get Info
from the File menu.

4. Expand the Plug-Ins tab of the info window. Make sure all the items pertaining to
spam and junk are unchecked. Click the Add button and then choose the SpamSieve
Eudora Plug-In file that you revealed in Step 2. You should now see this item checked
in the Plug-Ins list, and it should be visible in the About Message Plug-Ins window
when you launch Eudora.

3.6 Eudora 5.2
3.6.1 Installing

Using SpamSieve with Eudora 6 is highly recommended. However, SpamSieve can also work with
Eudora 5.2, and some Eudora 6 users may prefer the configuration described here because it is
more customizable.

Choose Show Other Scripts from SpamSieve’s SpamSieve menu. Move the SpamSieve Eudora
Helper file in the For Eudora 5.2 Users folder to the Applications folder of your hard disk.
You will need to launch this applet the first time you use SpamSieve with Eudora.

Also in the For Eudora 5.2 Users folder is the Uninstall Eudora Helper file. Run this applet
if you no longer want to use SpamSieve with Eudora.

Create a mailbox in Fudora called Spam that is at the same level as the In mailbox. When you
receive new spam messages, SpamSieve will move them to the Spam mailbox. It will also mark
good messages by setting their priority to lowest (indicated by two downward pointing carets) and
mark spam messages by setting their status to transfer error (indicated by a red “X”).
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3.6.2 Training SpamSieve

To train SpamSieve with spam messages, select one or more of them. Choose the Filter Messages
command in Eudora’s Special menu. Then double-click Train Spam.

Double-click an item bo tell SpamSieve
whal 1o do:

Add Cood

Add Spam

Add Spam and Falker
Filges

Skip

f Cancel F O :,

To train SpamSieve with good messages, select one or more of them. Choose the Filter Messages
command from Eudora’s Special menu. Then double-click Train Good.

3.6.3 Manually Processing Messages

To manually ask SpamSieve to mark or move messages that it thinks are spam, select one or more
of them. Choose the Filter Messages command in Eudora’s Special menu. Then double-click
Filter.

3.6.4 Setting Options

By configuring the SpamSieve Eudora Helper applet, you can tell SpamSieve to process your good
messages and spam messages in other ways. First, quit the applet. Then open it using the Script
Editor program in the AppleScript folder of your Applications folder. The top of the script
contains the following lines:

property moveToSpamFolder : true -- moves spams to a "Spam" mailbox
property markSpamMessages : true -- marks spams with red x

property markSpamMessagesRead : false -- marks spams as "already read"
property labelSpamMessages : false -- colors spam messages brown
property markGoodMessages : true -- marks good messages with carets
property labelGoodMessages : false -- colors good messages green

property removeSpamMessagesFromServer : false

You can change a false to true or a true to false to set the options the way you want. For
instance, to have SpamSieve not move spam messages into a separate mailbox, change the true in
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the first line to false. When you are finished making changes, choose Save in Script Editor’s File
menu, close the window, and then re-launch the SpamSieve Eudora Helper.

Script Editor 2.0 cannot edit the SpamSieve Eudora Helper applet. To customize the applet, use
Script Editor 1.9 or a third-party script editor.

3.6.5 Eudora Limitations

The following limitations are due to problems with Eudora’s “notification” interface. Because of
these limitations it is recommended that you use Eudora 6 and the SpamSieve Eudora Plug-In,
as described in the Eudora 6 section. The plug-in avoids these limitations.

e FEudora gives messages to SpamSieve after all the other filters have run. It is not possible to
change this ordering.

e SpamSieve cannot filter messages that are moved by other filters. For instance, if you have
a filter that moves incoming messages from Steve Jobs to a separate mailbox, SpamSieve
will not mark any of those messages as spam, even if a spammer pretends to be Jobs. This
limitation applies to both automatic filtering of incoming mail and manual filtering of selected
messages.

e Sometimes the wrong message is marked. That is, SpamSieve may decide that message A is
spam and ask Eudora to mark it with a red “X”; in rare circumstances, Eudora will instead
mark some other message B with the “X.” You can tell if this has happened by comparing
SpamSieve’s log to the way the messages are marked in Eudora. This problem seems to occur
when the In mailbox is sorted.

e Sometimes SpamSieve never sees a message that should have been filtered. You can tell if this
has happened by the absence of that message in the log. It may help to remove any “notify
user” filter action that you have set up.

e Sometimes SpamSieve determines that a message is good or spam, but Kudora does not mark
it at all. You can tell if this has happened by comparing SpamSieve’s log to the way the
messages are marked in Eudora.

e SpamSieve cannot add or filter messages that are stored in the Trash mailbox or in mailbox
files outside the Mail Folder folder in the Eudora Folder. Note that this includes all IMAP
messages. To access these messages, first move them to a non-trash mailbox file that is stored
inside the Mail Folder folder.

e If you manually apply filters while Eudora is in the process of downloading mail, Eudora will
show the SpamSieve dialog box twice. If this happens, just choose Skip the second time.

e Sometimes Fudora erroneously shows the SpamSieve dialog when you check for new mail.

e Sometimes after a long delay in talking to the mail server, Eudora stops notifying SpamSieve
when it receives new messages. You can work around this by quitting and re-launching the
SpamSieve Eudora Helper.
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3.7 GyazMail
3.7.1 Installing

To enable SpamSieve, open GyazMail’s Preferences window and click Junk Filter. Make sure
that Enable Junk filtering is checked and that the pop-up menu says SpamSieve.

By default, GyazMail will color the spam messages brown. If you want the spam messages to also
be put in a separate folder, create a folder called Spam. Then click on Rules in the Preferences
window and create a new rule as shown:

Description: | SpamSheve

Criteria:
™ Incoming | Outgaing W Manual (AID | Manual (Menu)
Status Ei is a Juni E! i;:
Match A -
Actions:
Mivve Mesige a 1o Falder: Spam [ Choete... ' - f:

Eﬁlnp applying rules to this meisage

( Cancel | bid

3.7.2 Training SpamSieve

To train SpamSieve with spam messages, select the messages, go to GyazMail’s Message menu,
and choose Junk > Mark as Junk. This will make the Message > Status > Junk item checked.

To train SpamSieve with good messages, select the messages, go to GyazMail’s Message menu,
and choose Junk > Mark as Not Junk. This will make the Message > Status > Junk item
unchecked.

You can also use the Junk button on the toolbar or the Message > Status > Junk menu command
to toggle the junk status of the selected messages.

To manually ask SpamSieve whether the selected messages are spam, choose Junk > Recheck
Junk Status from the Message menu.
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3.8 Mailsmith

3.8.1 Installing

Mailsmith 2.0 and later feature direct integration with SpamSieve. This is more convenient and
easier to use than the script- and filter-based integration that was necessary when using previous
versions of Mailsmith. You can enable SpamSieve simply by clicking the checkbox in the Spam
Handling pane of Mailsmith’s preferences. For more information about using SpamSieve with
Mailsmith, please see Chapter 8 of the Mailsmith User Manual.

3.8.2 Training SpamSieve

To train SpamSieve with spam messages, select one or more of them and then choose Mark as
Spam from Mailsmith’s Message menu. To train SpamSieve with good messages, select one or
more of them and then choose Mark as Non-Spam from Mailsmith’s Message menu.

3.8.3 Identifying Spam Messages

When using SpamSieve with Mailsmith, Mailsmith tags messages using the Is Spam and Is Not
Spam properties. Although you can use Mailsmith’s Advanced Query feature to search on
these properties, they are otherwise not visible in the user interface. Therefore, you should mark
spam messages in a visible way, either by letting Mailsmith move them to a separate mailbox, or
by setting up a filter to change the messages’ labels based on their Is Spam and Is Not Spam
properties. Otherwise, you will not be able to correct SpamSieve’s mistakes to improve its accuracy.

3.8.4 Mailsmith Extras

Choose Show Other Scripts from SpamSieve’s SpamSieve menu. This reveals the Mailsmith
Extras folder, which contains AppleScripts for use with Mailsmith. These make it possible for
scripters to further customize and automate the labeling and marking of messages in Mailsmith. If
you are using Mailsmith 2.0 and do not write AppleScripts, you can ignore the Mailsmith Extras
folder.

You can add the AppleScripts to Mailsmith’s Scripts menu by copying them to the Scripts folder

inside the Mailsmith Support folder. A filter such as the following may be used to change the
labels of incoming spam messages.
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8o # SpamSieve

Filter Criteria: More Criteria Fewer Criteria
If Raad ¥ Is Equal 1o ¥ True
Oir ¥ Read ¥ 14 Mot Equal 1 ¥ True

Filter Actions: More Acteand
Run Seript ¥ | SpamSieve - Label Spam v

This filter will pass all messages along to SpamSieve for analysis. It will set the Is Spam or Is Not
Spam property of the message, and change the label of the message if it is spam. This is roughly
equivalent to enabling SpamSieve in Mailsmith’s preferences, but because it uses AppleScript it is
more customizable. Additionally, you can change the filter criteria to pass only select messages
along to SpamSieve.

3.9 Outlook Express
3.9.1 Installing

Choose Show Other Scripts from SpamSieve’s SpamSieve menu. Copy the files from the For
Outlook Express 5 Users folder to the Script Menu Items folder inside the Microsoft User
Data folder (which is likely in your Documents folder).

Follow the instructions for Entourage v.X to create a rule in Outlook Express that applies the
SpamSieve - Move If Spam script. SpamSieve will now move new spam messages that you receive
to the Spam folder. If SpamSieve is not running when you receive new messages, it will launch
automatically.

3.9.2 Training SpamSieve

To train SpamSieve with spam messages, select one or more of them and then choose SpamSieve
- Train Spam from Outlook Express’s Scripts menu. To train SpamSieve with good messages,
select one or more of them and then choose SpamSieve - Train Good from Outlook Express’s
Scripts menu.

Make sure that you correct SpamSieve’s mistakes by using the commands in the Scripts menu—do
not click the underlined blue text to indicate that a message is not spam.

34



3.9.3 Manually Processing Messages

To manually ask SpamSieve to move messages that it thinks are spam, select the messages and
choose SpamSieve - Move If Spam from Outlook Express’s Scripts menu.

3.10 PowerMail 5

3.10.1 Installing

If you are using PowerMail 4, please see the PowerMail 4 section.

PowerMail 5 ships with built-in support for SpamSieve. To enable it, go to the Mark as Spam
pane of PowerMail’s Preferences window. Click the Spam filter assistant... button and tell
the assistant that you want to use SpamSieve. For more information about how to configure
PowerMail’s handling of spam messages, please see the PowerMail documentation.

3.10.2 Training SpamSieve

To train SpamSieve with spam messages, select one or more of them and then choose Mark as
Spam from the Mail menu. To train SpamSieve with good messages, select one or more of them
and then choose Mark as Good from the Mail menu.

3.11 PowerMail 4

3.11.1 Installing

Choose Show Other Scripts from SpamSieve’s SpamSieve menu. Copy the files from the For
PowerMail 4.x Users folder to the PowerMail Scripts folder inside the PowerMail Files folder.
The PowerMail Files folder is probably located in your Documents folder.
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If you want SpamSieve to label messages that it thinks are spam, set up a filter in PowerMail that
looks like this:

866 Mail Filters
-:gj-' & .ﬂ'. Description: SpamSieve = Label if Spam
. 5;.;;.5]., ¥ Fikter incoming messages [ Filter outgoing messages
Conditions:
a8
;W} Dredete Execute actions if | all conditions are met
Acricins:
Execute AppleScript B8 | spamsSieve - Label If Spam b5
T mdd Y ( Delete | Stop applying filters to this message

If, instead, you want SpamSieve to move suspected spam messages to a Spam folder (that it creates
automatically), set up the filter to use the SpamSieve - Move If Spam script instead.

SpamSieve will now mark or move new spam messages that you receive. If SpamSieve is not running
when you receive new messages, it will launch automatically.

3.11.2 Training SpamSieve

To train SpamSieve with spam messages, select one or more of them and then choose SpamSieve
- Train Spam from PowerMail’s Scripts menu. To train SpamSieve with good messages, select
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one or more of them and then choose SpamSieve - Train Good from PowerMail’s Scripts menu.

3.11.3 Manually Processing Messages

To manually ask SpamSieve to label or move messages that it thinks are spam, select the messages
and choose SpamSieve - Label If Spam or SpamSieve - Move If Spam from PowerMail’s
Scripts menu.

3.11.4 IMAP Accounts

PowerMail does not support moving IMAP messages via AppleScript, so if you use IMAP the
SpamSieve - Move If Spam script will not move spam messages into your Spam folder. IMAP
users should create the rule that uses the labeling script.

4 E-Mail Client Customization

SpamSieve works with your e-mail client to filter out spam messages. First, the mail client down-
loads new messages from the mail server. The mail client passes the messages to a plug-in or
AppleScript, which in turn passes them to the SpamSieve application. SpamSieve analyzes the
messages to see whether they are spam. It returns the verdict to the plug-in or script, which then
directs the mail client to move the messages to another folder.

4.1 Rule Ordering

Some of the e-mail clients that SpamSieve supports let you control the order in which the rules
(a.k.a. filters or mail actions) that you have created process mail. How you order the SpamSieve
rule is up to you. If you get a lot of spam that matches the rules you use to organize your mail,
you might want to run the SpamSieve rule first. This will allow it to find spam among all your
messages. If you would rather deal with spam manually than have any false positives, then you
might want to run the SpamSieve rule last, after all your other rules have been given a chance to
match and file away messages from known senders. Be sure to check the SpamSieve preferences for
additional filtering options.

4.2 The Change Settings Command

Apple Mail and Entourage users can use the SpamSieve - Change Settings command in the
Scripts menu to customize SpamSieve’s behavior in those programs. You can control which folder
spam messages are moved to, what happens to messages when they’re manually marked as spam
or good, and other options.
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4.3 Integrating With Other Applications

SpamSieve’s interface for integrating with third-party mail and news programs is completely open.
It is possible to add support for additional programs simply by writing some AppleScripts. Spam-
Sieve’s AppleScript dictionary contains some basic information about the supported commands.
However, there are some subtle, but important, points that are not discussed in the dictionary’s doc-
umentation. If you would like to connect an application to SpamSieve, please contact spamsieve@c-
command.com?’ so that I may assist you.

5 Menus

5.1 The File Menu
5.1.1 Import Addresses...

This imports either good or spam e-mail addresses from a text file. For each address, a rule is
created on the whitelist (or blocklist) that matches messages sent from that address. If such a rule
already exists, SpamSieve makes sure that it’s enabled. Rules in the opposite list are not affected.

Many file formats are supported: the addresses can be return- or comma-delimited, or they can be
mixed in with message text as part of a mbox file.

e To import addresses from Entourage, choose Export... from the File menu and select the
option to Export contacts to a tab-delimited text file.

e To import addresses from Eudora, ask SpamSieve to import the Eudora Nicknames file inside
the Eudora Folder (which is likely in your Documents folder).

e To import addresses from the Mac OS X address book, open the Address Book program.
Choose Card and Columns from the View menu. Select all the names in the middle
column (Name) and drag them to the desktop. This will create a file called vCards.vcf,
which you can import into SpamSieve.

You may be wondering why you would want to import addresses from the Mac OS X address book
instead of using the Use Mac OS X Address Book preference, or why you would import addresses
from Entourage instead of using the Use Entourage address book preference. The difference is as
follows. When you ask SpamSieve to use an address book directly, it will always consider messages
from senders in the address book to be good—even if you receive many spam messages that are
forged to appear as if they were sent by your friends.

When the addresses are imported to the whitelist, however, they are subject to SpamSieve’s normal
whitelist behavior. That is, if Train SpamSieve whitelist is checked, when you receive a spam

'nailto: spamsieve@c-command.com
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message from someone on the whitelist, SpamSieve will disable the corresponding whitelist rule.
Subsequent messages from that sender will no longer be whitelisted. In short, the address book is
safer because it makes sure messages from people in your address book always get through. The
whitelist is less safe, but it allows you to block forged spam messages.

5.1.2 Import Corpus...

This imports the words in a corpus that was exported in XML format. This is the same format
used by SpamSieve 1.x. Importing a corpus merges it with the active corpus. To replace the active
corpus with the one you are importing, use the Reset Corpus... command before importing.

5.1.3 Export Corpus...

This exports the active corpus to XML format. You might do this in order to import the corpus
on another machine.

5.1.4 Import Messages...

This imports messages stored in mbox format. You can select whether the mbox file contains good
messages or spam messages. 1o replace the active corpus with the messages you are importing, use
the Reset Corpus... command before importing.

5.2 The Filter Menu

5.2.1 Show Corpus

This command opens the Corpus window so that you can examine the words that SpamSieve has
found in your e-mails. You can click on the name of a column to sort by that column. Click again
on the column to reverse the sort direction. The meanings of the columns are as follows:

Word

A word in the corpus.
Spam

The number of times the word has occurred in spam messages.
Good

The number of times the word has occurred in good messages.

Total

The total number of times the word has occurred.
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Prob.

The probability that a message is spam, given that it contains the word (and in the absence
of other evidence).

Last Used

The date that the word was added to the corpus, or the date that it last appeared in a received
message (whichever is later).

You can copy the selected rows to the clipboard or drag and drop them into another application.

With the window sorted by Word, you can type the first few letters of a word to locate that word
in the corpus. Similarly, you can sort by one of the other columns and type a number to locate the
first word whose value for the sorted column matches the number you typed.

You can edit the spam and good counts associated with a word by double-clicking on the number
in the Spam or Good column. Changing the numbers for important words can greatly affect
SpamSieve’s accuracy, so you shouldn’t make changes without good reason.

You can remove words that you don’t want in the corpus by selecting them and pressing Delete.

5.2.2 Prune Corpus...

This command removes from the corpus words that have not been used in a set number of days.
This can decrease SpamSieve’s memory use and increase its speed. However, pruning can reduce
SpamSieve’s accuracy, so you should only prune if you find that SpamSieve is using too many
system resources.

5.2.3 Reset Corpus...

This command removes all the words and messages from the corpus. This will enable you to retrain
SpamSieve from scratch, and SpamSieve will let you use your old messages in the retraining.

5.2.4 Show Statistics

This command opens the Statistics window, which displays the following information:

Good Messages

The number of non-spam messages that SpamSieve has filtered.

Spam Messages

The number of spam messages that SpamSieve has filtered.
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Spam Messages Per Day

The average number of spam messages received per 24-hour period.

False Positives

The number of good messages that SpamSieve identified as spam.

False Negatives

The number of spam messages that SpamSieve identified as good.

% Correct

The percent of messages that SpamSieve identified correctly.

Good Messages

The number of non-spam messages that are used to identify spam messages.

Spam Messages

The number of spam messages that are used to identify spam messages.

Total Words

The total number of unique words in the corpus.

Blocklist Rules

The number of rules on SpamSieve’s blocklist.

Whitelist Rules

The number of rules on SpamSieve’s whitelist.

You can copy all the statistics to the clipboard using the Copy command in the Edit menu or by
clicking the Copy Stats button.

Normally, SpamSieve shows statistics for all the messages that it processed since it was installed.
Because the accuracy and the number of messages you receive change with time, you may wish to
only see recent statistics. Click the Set Date... button at the bottom of the window to control
which old statistics are hidden from view. You can edit the date and time shown in the sheet, or
enter an entirely new date. SpamSieve will accept dates specified in natural language, such as “last
Sunday at dinner” or “today.” The Now button enters the current date and time.

5.2.5 Open Log

SpamSieve keeps a log of messages that it has filtered, words that it has used to decide whether the
messages were spam, messages you have added to the corpus, and any errors that have occurred.
This command opens the log file so that you can look at it. Normally, there is no reason (aside from
curiosity) to look at the log file. However, if you believe SpamSieve is not working as it should, the
log file provides useful information about what SpamSieve has done. If you find that the log file is
taking up too much disk space, you can delete it at any time. SpamSieve will then start a new log
file as needed.
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5.2.6 Edit Log

This command opens the log file in a text editor instead of Console. This makes it easier to read
and search large log files.

5.2.7 Show Blocklist

This opens the Blocklist window. The blocklist consists of a list of rules. If a message matches
one or more rules on the blocklist, SpamSieve will predict that it is spam. Each row in the blocklist
window represents one rule. The meanings of the columns are as follows:

Date
The date that the rule was added to the blocklist.

Header
The part of the message that will be matched against the rule.

Match Style

How the rule text will be matched against the text from the message’s header.

Text to match
The text that will be matched against the message’s header.

v

If this is checked, the rule is enabled. Disabled rules do not block any messages.

Hits

The number of spam messages that the rule blocked, a rough measure of how effective it is.

When SpamSieve checks whether a message matches a rule, it compares the part of the message
named by the Header column with the contents of the rule’s Text to Match column. The
following are the message parts that may be used in the Header column:

From (address)

The e-mail address of the message’s sender.

From (name)

The name of the message’s sender.

To (any address)

The e-mail addresses of the primary recipients of the message. SpamSieve checks each recip-
ient separately to see whether it matches the rule.
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CC (any address)
The e-mail addresses of the carbon copy recipients of the message. SpamSieve checks each
recipient separately to see whether it matches the rule.

Reply-To (address)
The address that you would be sending to if you replied to the message. This is often the
same as the From address, but it could also be a mailing list or an alternate address for the
sender. If the message does not specify a Reply-To, then the rule will not match.

Any Recipient
The To and CC addresses.

Any Address
The From, To, CC, Reply-To, and SendTo addresses.

List-ID
For mailing list messages, this hidden header indicates which mailing list the message was
sent to.

List-Unsubscribe
For mailing list messages, this hidden header indicates how to unsubscribe from the mailing
list. Some mailing list messages that do not have a List-ID header do have a List-Unsubscribe
header.

Mailing-List
For mailing list messages, this hidden header indicates which mailing list the message was
sent to. Some mailing list messages that do not have a List-ID header do have a Mailing-List
header.

Received (any)
The Received headers contain information about the servers that relayed the message on its
journey from the sender to the recipient.

Return-Path

This header contains information about where the message originated.

Subject
The subject of the message.

Body (any text part)

The contents of the message. Some messages contain more than one text part (for instance,
plain text and HTML representations of the same message). The rule matches the message
if any of the text parts matches the rule’s text.

Any Character Set

The character set often indicates the language of the message. Many spam messages are sent
using Asian character sets. The IANA maintains a list of character sets?!.

2'mttp://www.iana.org/assignments/character-sets
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Any Attachment Name

Many spam messages contain attachments whose names end with .pif.

There are several different ways in which SpamSieve can compare the text in the message’s header
to the rule’s text. In all cases, capitalization does not matter; lowercase letters are considered the
same as their uppercase counterparts.

Is Equal to

The message matches the rule if its text is exactly the same as the rule’s text. This is the
fastest style of matching.

Contains

The message matches the rule if the message text contains the rule text.

Starts with

The message matches the rule if the message text begins with the rule text.

Ends with

The message matches the rule if the message text ends with the rule text. This is useful for
matching domain names. For example, to match messages sent from Apple, you could create
an Ends with rule with text @apple.com.

Matches Regex

This is like Contains, except that the rule text is treated as a Perl-compatible?? regular expres-
sion?3. Regular expressions are a powerful way of specifying patterns of text, for instance:
e-mail addresses that contain numbers before the @ sign or subjects that are longer than
30 characters. If the regular expression entered in the Text to Match column is invalid,
SpamSieve will color it in red, and it will not match any messages.

You can edit a rule’s Header or Match Style by clicking in the corresponding column and selecting
from the pop-up menu. To edit a rule’s Text to Match, double-click the text. The SpamSieve
Web site shows some examples of possible rules??.

Training SpamSieve with a spam message adds its sender to the blocklist. You can delete a rule
from the blocklist by selecting it and pressing Delete. You can copy the selected rules to the
clipboard or drag and drop them into another application. You can type the first few letters of a
rule’s Text to Match to quickly locate that rule.

SpamSieve ships with some blocklist rules pre-configured to catch messages containing spammy
attachments and also messages sent using non-Latin character sets (another common spam char-
acteristic).

?Znttp://pcre.org/pere. txt
nttp://zez.org/article/articleview/11/
2nttp://c-command . com/spamsieve/screenshots
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5.2.8 Show Whitelist

The whitelist works the same way as the blocklist except that messages sent from addresses on the
whitelist are never considered to be spam. The whitelist also has special support for mailing lists.
If you train SpamSieve with a good message from a mailing list, it will add a rule to the whitelist
that matches the message’s mailing list header (List-ID, List-Unsubscribe, or Mailing-List). Then
SpamSieve will know that all messages from that mailing list are good, regardless of who sent them.

The whitelist is most commonly used for matching messages sent from particular addresses, do-
mains, or mailing lists. You can also use the whitelist to create codewords. For instance, you could
create a rule in the whitelist that matches subjects containing “eggplant” (or some other word
unlikely to occur in regular mail). You can tell select people to put “eggplant” in the subject of
messages that they send you, and then you can be assured that their messages will get through,
even if the sender addresses are not in your address book or whitelist.

5.2.9 Add Rule

This command creates a new rule in either the whitelist or blocklist. This is useful if you want to
add your own rules to the whitelist or blocklist, rather than having SpamSieve learn the rules when
you train it with messages.

5.2.10 Show Training Tip

This opens the Training Tip window, which gives advice for improving SpamSieve’s accuracy,
based on your current corpus and preferences.

6 Preferences

6.1 Filters
6.1.1 Order

SpamSieve uses a variety of filters to determine whether messages are spam or good. It consults
the filters in the order listed in this window. When a filter decides that the message is good or
spam, SpamSieve stops moving down the list. Thus, the order of the filters makes a difference. You
can see from the order that if a message’s sender is on the whitelist, it will be marked as good even
if the Bayesian classifier would have predicted it to be spam. Normally this is what you want; the
point of a whitelist is that you can be sure that certain messages will never be marked as spam.
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6.1.2 Check for message in corpus

SpamSieve learns as you train it, but training is not instant. Training SpamSieve with a message
will not necessarily give it enough information to classify that message correctly based only on the
words in the message. However, once you have added a message to the corpus, SpamSieve knows
whether it is good or spam, even though it might not make the correct prediction based on word
probabilities. This option causes SpamSieve to see if it knows whether a message is good or spam
before trying to calculate its spam probability. If SpamSieve has seen the message before, it will
always classify it correctly. You can disable this option if you want to see what SpamSieve would
have predicted if it did not already know whether the message was good or spam.

6.1.3 Use Mac OS X Address Book

With this option enabled, SpamSieve will never predict a message to be spam if its sender’s e-mail
address is in the system address book.

You can add addresses to the system address book using the Address Book application (located
in the /Applications folder), or directly from an e-mail client that supports the system address
book.

Mailsmith and PowerMail users should be sure to enable the option to use Apple’s Address Book.
Entourage users may prefer to use their address book as a whitelist instead of Apple’s. This is
described in the Entourage 2004 section.

6.1.4 Exclude my addresses

Enable this option so that spam messages with your own return address are not marked as good.
Disable it if you send yourself messages and want to make sure that they are never marked as
spam. SpamSieve looks on the “Me” card in Apple’s Address Book to determine which addresses
are yours.

6.1.5 Use Entourage address book

With this option enabled, SpamSieve will not predict a message to be spam if its sender’s e-mail
address is in the Entourage address book. However, if you have Exclude my addresses checked,
addresses on the Mac OS X address book’s “Me” card will not be checked against Entourage’s
address book. This helps prevent forged spams from getting through.

When you start using SpamSieve, you should click the Load button to make SpamSieve read in the
addresses in the Entourage address book. (This will cause SpamSieve to launch Entourage if it is
not already open.) The addresses are loaded into SpamSieve’s memory and stored in its preferences
file, but they are not displayed in the Whitelist window.
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Whenever you add addresses to the Entourage address book, you should go back to SpamSieve’s
preferences and click Load so that SpamSieve learns about the new addresses. Do not click Load
while Entourage is downloading and filtering mail, as this may cause it to freeze.

Note that the Load button will not work unless Warn before allowing an external application
to access the address book is unchecked in Entourage’s Security preferences.

6.1.6 Use SpamSieve whitelist

Enable this option so that messages sent from addresses on the SpamSieve whitelist are never
marked as spam.

6.1.7 Use SpamSieve blocklist

Enable this option so that messages sent from addresses on the SpamSieve blocklist are always
marked as spam.

6.1.8 Use Habeas Whitelist

The Habeas Whitelist?? is list of senders who agree to only send e-mail that meets Habeas’ stringent
compliance requirements. With this option checked, SpamSieve will consider a message to be non-
spam if finds the sending mail server’s IP address on the Habeas Whitelist. This entails contacting
Habeas’ server to lookup the address, but there is little performance penalty for doing this, since
SpamSieve only contacts the server when the message contains Habeas headers:

X-Habeas-SWE-1: winter into spring

X-Habeas-SWE-2: brightly anticipated

X-Habeas-SWE-3: like Habeas SWE (tm)

X-Habeas-SWE-4: Copyright 2002 Habeas (tm)

X-Habeas-SWE-5: Sender Warranted Email (SWE) (tm). The sender of this
X-Habeas-SWE-6: email in exchange for a license for this Habeas
X-Habeas-SWE-7: warrant mark warrants that this is a Habeas Compliant
X-Habeas-SWE-8: Message (HCM) and not spam. Please report use of this
X-Habeas-SWE-9: mark in spam to <http://www.habeas.com/report/>.

6.1.9 “ADV” messages are spam

This option causes SpamSieve to always mark messages as spam if they contain some variant of
“ADV” at the start of the subject line. The “ADV” marker is used by some commercial bulk
mailers.

2*http://www.habeas . com/supportWhiteList.html
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6.1.10 Encoded HTML mail is spam

Many spammers encode the contents of their messages with base-64 so that filters cannot see
the incriminating words they contain. SpamSieve can decode and look inside these messages. This
option causes it to mark all such as spam, regardless of their contents, on the theory that legitimate
senders do not try to obscure their messages. This does not affect messages encrypted with PGP26,

6.1.11 Use Bayesian classifier

This enables SpamSieve main spam detector, which uses the corpus and word probabilities to
identify spam messages.

6.2 Notification
6.2.1 What Is Notification?

All e-mail clients can notify you when you receive new messages, but most will also notify you even
when all the new messages are spam. If your e-mail client is not savvy in this way, you can turn
off its notification and let SpamSieve notify you only when there are new good messages.

6.2.2 Play sound

This makes SpamSieve play a sound when new good messages are received. To add a sound to the
menu, copy the sound file to the Sounds folder in your Library folder. SpamSieve will also look
for sounds that are built into your installed e-mail programs.

6.2.3 Bounce Dock icon

This makes SpamSieve bounce its Dock icon once when new good messages are received.

6.2.4 Keep bouncing

You might not be looking at the Dock icon when it first bounces, so this makes SpamSieve continue
bouncing its Dock icon until you activate SpamSieve or your e-mail client.

2nttp: //www.pgp. com/products/desktop/personal/index.html
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6.2.5 Show number of new good messages in Dock

This option makes SpamSieve show the number of new good messages in its Dock icon. If there are
no new good messages or if SpamSieve or the mail program is frontmost, SpamSieve will not show
any number (rather than showing zero). Clicking the Dock icon, activating your e-mail client, or
training SpamSieve with a message will reset the count.

The three sliders control the size and position of the number in the Dock icon.

If you're using DragThing?” 5.3 or later, SpamSieve can show the message count in its tile in
DragThing’s process dock. With DragThing 5.3 and 5.3.1, you will need to install a file to enable
this integration. Choose Show Other Scripts from the SpamSieve menu, and then open the For
DragThing Users folder. In a separate window, locate the DragThing application. Control-click on
the DragThing icon and choose Show Package Contents. Open the Contents folder and then
the Resources folder. Control-click on the DragThing Helper file and choose Show Package
Contents. Open the Contents folder and then the Resources folder. Drag the mtSS.scpt file
from the For DragThing Users window into the Scripts folder in the Resources window.

6.2.6 Flash PowerMate

If you have a Griffin PowerMate?®, this option will make it flash when new good messages arrive.
The flashing will stop when you activate SpamSieve or your mail program.

To change the rate of the pulsing, open System Preferences and go to the PowerMate pane. Adjust
the Rate slider in the Pulsing section of the window.

6.2.7 Notify with Growl

Once you have installed Growl??, the next time SpamSieve is launched it will use Growl to notify you
when new messages arrive. You can customize the notification style and enable/disable notifications
using the Growl pane in System Preferences. The following notifications are available:

Good Message Count

This notification mimics the red number in SpamSieve’s Dock icon. After a batch of good
messages arrives, it tells you how many new messages there are and then fades away.

Good Messages (in Address Book)

This posts one notification for each good message that arrives (where the sender is in your
address book), showing the message’s subject, the first few lines of its body, and (if possible)
a picture of the sender.

2"http://www.dragthing. com
2®nttp://www.griffintechnology.com/products/powermate/
Pnttp://www.growl.info
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Good Messages (Not in Address Book)

This posts one notification for each good message that arrives (where the sender is not in
your address book), showing the message’s subject and the first few lines of its body.

Uncertain Spam

This notification helps you spot false positives by telling you when a message has arrived
that SpamSieve thinks is spam, but that may actually be good. SpamSieve assigns each
message a score between 0 and 100, and it considers messages with scores 50 or greater to
be spam. Message with scores above 90 are almost certainly spam. Most messages with
scores in the 70s are also spam, but if there are any false positives they will likely be in this
range. In SpamSieve’s preferences, you can set the score range for “uncertain spam”, and then
you will get a Growl notification for each message with a score in this range. By watching
these notifications, you can spot false positives without having to look through the entire
contents of the spam folder in your mail client. Unlike the other notifications, Uncertain
Spam notifications will persist until you click to dismiss them.

6.3 Training

6.3.1 Allow duplicates in corpus

If you allow duplicate messages in the corpus, adding the same message twice will increase the
counts for the words in that message. If you do not allow duplicate messages, the second and
subsequent times you try to add a message will have no effect. By default, duplicate messages are
not allowed in the corpus. This is nice because it means that you do not have to remember which
messages you have already added; accidentally adding the same message more than once will not
skew the data that you are providing to SpamSieve. If you wish to intentionally skew the data, you
can check one or both boxes to allow duplicates.

6.3.2 Auto-train with incoming mail

This option causes SpamSieve to automatically train itself with newly received messages based on
their predicted categories. Thus, after the initial training you would only need to train SpamSieve
to correct its mistakes; it would automatically learn from the other new messages, as needed.

Note that with this option enabled it is imperative that you correct SpamSieve when it makes a
mistake; otherwise it will be making predictions based on incorrect information.

6.3.3 Train SpamSieve whitelist

With this option enabled, training SpamSieve with a good message will add the message sender’s
name and address to SpamSieve’s whitelist. Training SpamSieve with a spam message will disable
the name and address if they appear in the whitelist.
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Example: You receive an Amazon order receipt and train SpamSieve with it as a good message.
This puts auto-confirm@amazon.com on the whitelist so that future order receipts are always
marked as good. A spammer might decide that auto-confirm@amazon.com would make a good
fake return address. If you receive such a spam, SpamSieve would mark it as good because the
sender was on the whitelist. If you then tell SpamSieve that the message is spam, it will disable
the whitelist rule so that it can catch future spam messages with that return address.

6.3.4 Train SpamSieve blocklist

With this option enabled, training SpamSieve with a spam message will add the message sender’s
name and address to SpamSieve’s blocklist. Training SpamSieve with a good message will disable
the sender’s name and address if they appear in the blocklist.

6.3.5 Train Bayesian classifier

With this option enabled, training SpamSieve with a message will add the words from that message
to SpamSieve’s corpus. It is highly recommended that you train the Bayesian classifier, as this is
how most spam messages are caught.

6.3.6 Show training tip at startup

With this option enabled, SpamSieve will open the Training Tip window each time it is launched.

6.4 Advanced

6.4.1 Spam-catching Strategy

This slider lets you adjust SpamSieve’s bias. The bias controls how aggressive SpamSieve is at
catching spam. When SpamSieve is more aggressive, it is better at catching spam messages that
share some characteristics with your good mail. When SpamSieve is more conservative, it will be
better at marking borderline messages such as order confirmations and press releases as good. This
setting is very powerful, and most users should stick to the middle range. It is also not a substitute
for training SpamSieve. Only change the bias if SpamSieve is consistently making errors in the
same direction.

6.4.2 Save false negatives to disk

False negatives are spam messages that SpamSieve didn’t catch. This option causes SpamSieve
to save such messages for later analysis. Clicking the Show button opens the folder contain-
ing the saved messages. You can e-mail this folder, or selected files from it, to spamsieve-fnQc-
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command.com?®’. By looking at the messages that SpamSieve missed, I can improve its algorithms
to catch such messages in the future. Note that enabling this option will slow down SpamSieve’s

processing.

6.4.3 Use photo-realistic Dock icon

This option causes SpamSieve to use a more modern Dock icon, which may or may not fit in better
with your other Dock icons.

7 Frequently Asked Questions

7.1 Why is SpamSieve not catching my spam?

There are two basic causes of poor accuracy:

Setup

SpamSieve itself may be working properly, but if it does not have access to your incoming
messages, it won’t be able to tell which ones are spam. The setup process for Apple Mail,
Entourage, and PowerMail involves creating a rule in the mail program. When this rule is
applied to a message, SpamSieve can examine its contents and send it to the spam folder (if
it’s spam).

Make sure that you have a rule that looks exactly like the one in the SpamSieve manual.
To test that the rule works, select a spam message in your mail program. Use the Train
Spam (Apple Mail or Entourage) or Mark as Spam (PowerMail) command to tell
SpamSieve that it is spam. Drag this message to your inbox and select it again. Then
manually apply the rule and verify that the message is marked as junk or moved back
to the spam folder. To manually apply the rule:

— In Apple Mail, choose Apply Rules from the Message menu. (This will apply all
the rules so, for testing purposes, move the SpamSieve rule to the top of the rule
list.)

— In Entourage, choose Apply Rule > SpamSieve - Move If Spam from the
Message menu.

— In PowerMail, choose Perform Filter > Spam: evaluate from the Mail menu.
If you are using Apple Mail and SpamSieve is no longer working (but was working
previously), try quitting Mail and then using the Install Apple Mail Plug-In and
Scripts command in the SpamSieve menu. Often, this is all you'll need to do to get
it working again.

If you are using Entourage:

30
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Training

— Make sure that your rule is of the proper type. That is, if you have a POP account,
you need a POP rule; if you have an IMAP account, you need two IMAP rules.

— Try installing fresh copies of the scripts. To do this, choose Install Entourage
Scripts from the SpamSieve menu, and let it replace the existing files. Then go
to Entourage’s Rules window and delete and re-create the SpamSieve rule.

If you are using Mailsmith, make sure that Use SpamSieve is checked3! in the prefer-
ences.

If you are using PowerMail, try replacing your PowerMail application with a fresh copy.
Then delete the filters for SpamSieve in PowerMail’s Mail Filters window and go
through the Spam Filter Assistant to re-create them.

Try moving the SpamSieve rule higher in the rule list. It’s possible that other rules
are preventing the SpamSieve rule from being applied to some or all of the incoming
messages, causing SpamSieve not to see those messages. Moving the SpamSieve rule
higher in the list gives it priority.

In Entourage, Mailing List Manager rules are implicitly higher than the regular rules,
and they can often interfere with the regular rules, even if it looks like they wouldn’t.
Try deleting any Mailing List Manager rules, or re-creating them as regular rules.

SpamsSieve is nearly 100% accurate, but only when properly trained. For best results, the
corpus should have about 65% spam messages, as shown at the bottom of the Statistics
window. You can train SpamSieve with more messages to improve this ratio.

The messages in the corpus should be representative of the messages that you receive. Adding
more messages to the corpus generally improves accuracy, but it is not necessary to have more
than a few thousand messages in the corpus (and having more than that will probably reduce

accuracy).

7.2 How can I copy my training data to another machine?

SpamSieve stores its training data in the folder:

/Users/<username>/Library/Application Support/SpamSieve/

and it stores its preferences in the file:

/Users/<username>/Library/Preferences/com.c-command.SpamSieve.plist

To transfer SpamSieve’s data to another machine, first quit both copies of SpamSieve. Then copy
the above-mentioned items from one machine to the corresponding location on the other machine.

3mttp: //www.barebones . com/support/faq/faq.php?action=question&minor_id=9&question_id=117
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7.3 Why doesn’t my serial number work?

You need to enter the serial number name and serial number exactly as they appear on your order
confirmation e-mail. If you no longer have this e-mail, you can look up the name and number by
clicking the Lost Your Serial Number? button in SpamSieve’s Purchase window.

7.4 How can I hide SpamSieve’s Dock icon?

The easiest way is to use the free Dockless®? utility. You’ll need to make the Dock icon visible
again in order to configure SpamSieve’s preferences, view the statistics, or access any other part of
SpamSieve’s user interface.

Alternatively, you can do this manually. Hold down the Control key and click on the SpamSieve
icon in the Finder. Choose Show Package Contents from the menu. Open the Contents folder,
and then open the Info.plist file. At the bottom of Info.plist, change:

<key>LSUIElement</key>
<string>0</string>

to:

<key>LSUIElement</key>
<string>1</string>

Then save the Info.plist file and relaunch SpamSieve. You may need to temporarily move the
SpamSieve application to the desktop and double-click it there in order for Mac OS X to notice
that you now want the Dock icon hidden. To make SpamSieve’s Dock icon visible again, change
the Info.plist file back; that is, change the 1 back to a 0.

7.5 How does SpamSieve compare with Eudora’s SpamWatch?

Although both use similar technology, SpamSieve’s Bayesian classifier is more accurate and learns
more quickly. SpamSieve is also more customizable. For instance, it lets you create a whitelist and
a blocklist in addition to using the Bayesian classifier. If you look at the Filters tab of SpamSieve’s
Preferences window, none of the items above “Use Bayesian Classifier” are supported by Eudora.
Lastly, SpamSieve can work with the Sponsored (free) Eudora, while SpamWatch requires the Paid
(850) version of Eudora.

32nttp://homepage .mac.com/fahrenba/dockless/dockless.html
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7.6 Is SpamSieve 2.2.4 a free upgrade?

Yes, if you already purchased SpamSieve you do not need to purchase it again. Your registration
name and serial number will continue to work with 2.2.4.

7.7 Why don’t I see the Junk command in Eudora’s Message menu?

The Eudora installation instructions show how to enable this command from the esoteric settings.

7.8 How can I use SpamSieve with AOL?

There are three ways:

e AOL has recently announced support for IMAP. This means that you can check your AOL
mail—and use SpamSieve to filter it—using e-mail clients other than AOL’s own. I recom-
mend using Apple Mail, since it has the best IMAP support among the mail clients that work
with SpamSieve. You should configure3® Mail using your AOL screen name and password.
Set the IMAP server to imap.aol.com (port 143) and the SMTP server to smtp.aol.com
(port 587).

e If you already have a copy of Claris Emailer, you can configure it to access your AOL account
and filter the mail using SpamSieve.

e You can use a utility such as Mail Forward** to forward your AOL mail to a POP account.
Then you can download the messages using any of the e-mail clients that SpamSieve supports.

7.9 What information should I include when I report a problem?

If you are reporting a problem with SpamSieve’s accuracy, open the Statistics window and choose
Copy Stats in the Edit menu so that you can paste all your statistics into the message. Also, use
the Open Log command in the Filter menu and include any relevant entries from the log.

7.10 Why does SpamSieve try to connect to dreamhost.com when it starts up?

It’s checking to see whether there’s a newer version of SpamSieve available. You can disable this
feature from the Software Update window that’s accessible from the SpamSieve menu.

33nttp://help.channels.aol.com/article.adp?catId=14sCId=416&sSCId=4093%articleId=217449
3nttp://www.sspi-software.com
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7.11 Where can I download the older Mac OS 9 version?

There has never been an OS 9 version of SpamSieve—sorry.

7.12 Can I delete spam messages after training SpamSieve with them?

Yes. It is not necessary to keep the spam messages in your e-mail client’s spam folder.

7.13 What is the difference between Train Spam and Move If Spam?

The Train Spam command causes SpamSieve to learn from the selected messages. SpamSieve
learns that they are spam, and then it moves the messages to the Spam folder in your e-mail
program.

The Move If Spam command asks SpamSieve to predict whether the messages are spam. If it
thinks that they are, it will move them to the Spam folder. Generally, you do not need to use the
Move If Spam command directly; it will be automatically applied to incoming messages by the
rule that you created in your e-mail program.

8 Purchasing and Support

8.1 Contact Information

You can download the latest version of SpamSieve from the SpamSieve Web site3®. Questions
about SpamSieve may be sent to spamsieve@c-command.com®®. I'm always looking to improve
SpamSieve, so please feel free to send any feature requests to that address.

To make sure that you have the latest version of SpamSieve, you may wish to subscribe to the
SpamSieve News mailing list3”. The traffic on this list is very low, only one message per new
version of SpamSieve.

8.2 Purchasing

SpamSieve has a free trial period that lasts for 30 days or 20 launches, whichever is longer. To use
SpamSieve beyond the demo period, you must purchase it. This entitles you to free updates and
support.

3http://c-command . com/spamsieve/
3mailto: spamsieve@c-command. com
3"http://c-command . com/spamsieve/support
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To purchase, choose Purchase. . . from the SpamSieve menu. You can use the Instant Purchase. ..
button to enter your billing information from within SpamSieve or use the Web Purchase. .. but-
ton to enter it from your Web browser.

Soon after paying, you'll receive an e-mail with your serial number. If you used Instant Purchase. . .,
you're done. If you used Web Purchase. .., enter the name and serial number from the e-mail
into the Purchase window and click Personalize. If you need to re-install SpamSieve, you can
simply re-enter your name and serial number and click Personalize; there’s no need to purchase
again.

If you purchased SpamSieve but cannot find your serial number, click the Lost Your Serial
Number? button. This will open a form where you can enter your e-mail address and look up
your order information.

A license for SpamSieve is good for one person or one computer. You can install it on one Mac,
and everyone sharing that Mac can use it (on that Mac). Alternatively, you can install it on your
desktop Mac and your PowerBook; you can then use it on either machine, provided that no one is
using it on the other machine.

8.3 Legal Stuff

SpamSieve and this manual are copyright (© 2002-2005 by Michael J. Tsai®®. All rights reserved.

Please distribute the unmodified SpamSieve-2.2.4.dmg file on the Web, LANs, compilation CD-
ROMs, etc. Please do not charge for it (beyond a reasonable cost for media), or distribute the
contents of the image file in isolation. Do not distribute your serial number.

The software is provided “as is,” without warranty of any kind, express or implied, including but not
limited to the warranties of merchantability, fitness for a particular purpose and noninfringement.
In no event shall the authors or copyright holders be liable for any claim, damages or other liability,
whether in an action of contract, tort or otherwise, arising from, out of or in connection with the
software or the use or other dealings in the software.

SpamSieve is a trademark of Michael Tsai. Mac is a registered trademark of Apple Computer. All
other products mentioned are trademarks of their respective owners.

The following open-source components are used in SpamSieve:

Regular expression support is provided by the PCRE?® library package, which is open source
software, written by Philip Hazel, and copyright by the University of Cambridge, England.

EDCommon?? is Copyright (© 19992002 by Erik Doernenburg. All rights reserved. Permission
to use, copy, modify and distribute this software and its documentation is hereby granted, provided
that both the copyright notice and this permission notice appear in all copies of the software,

38mailto:mjt@c-command.com

3nttp://www.pcre.org
“Ohttp://www.mulle-kybernetik.com/software/EDFrameworks/download.html#EDCommon
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derivative works or modified versions, and any portions thereof, and that both notices appear in
supporting documentation, and that credit is given to Erik Doernenburg in all documents and
publicity pertaining to direct or indirect use of this code or its derivatives.

EDMessage*! is Copyright (©) 2000—2002 by Erik Doernenburg and Axel Katerbau. All rights
reserved. Permission to use, copy, modify and distribute this software and its documentation is
hereby granted, provided that both the copyright notice and this permission notice appear in all
copies of the software, derivative works or modified versions, and any portions thereof, and that
both notices appear in supporting documentation, and that credit is given to Erik Doernenburg in
all documents and publicity pertaining to direct or indirect use of this code or its derivatives.

9 Version History

2.2.4—February 10, 2005

e Increased the speed of SpamSieve’s message processing.

e Processing messages with Entourage is much faster. To realize the speed increase, re-
install SpamSieve’s Entourage scripts and let it replace the existing ones.

e Improved accuracy through better HTML and header processing. (It is not necessary to
reset the corpus.)

e Colors to indicate spamminess in Apple Mail are now enabled by default.

e Now plays sounds (and bounces the Dock icon) when mail arrives, even if SpamSieve or
a mail program is frontmost.

e Added option to Entourage’s Change Settings to make all spam messages marked with
category Junk instead of marking some of them with Uncertain Junk.

e Added more standard blocklist rules for non-Latin character sets.

e AppleScript errors complaining about not being able to find the SpamSieve application
should be much less common now. If you do see such an error, asking SpamSieve to
re-install the scripts for Apple Mail or Entourage (and letting it replace the existing
scripts) should cure things.

e Improved name and serial number entry.

e The Edit Log command is no longer an alternate menu item.

e Can now load Entourage addresses when Launch Services can’t find Entourage.
e The default classifier reports better scores.

e The behavior of the default classifier (if no rules or other classifiers match, and the
Bayesian classifier is disabled) may now be changed by setting the DefaultIsGood de-
fault. Normally this is YES, but you can set it to NO to make SpamSieve treat all
non-whitelisted messages as spam.

e Pruning now is recorded in the log.
e Updated the Russian localization.

e Added Swedish and Vietnamese localizations.

“http://www.mulle-kybernetik.com/software/EDFrameworks/download.html#EDMessage
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Expanded and improved the manual.

The Entourage scripts no longer mark messages with multiple copies of the same cate-
gory.

Fixed bug where SpamSieve would sometimes incorrectly think that it had made a
mistake (if auto-training was on and the user had asked it to reclassify a message).

Fixed bug in the Change Settings scripts.

No longer reports an error when trying to reset an empty initial corpus.
Fixed crash when quitting after resetting an empty corpus.

Fixed bug where SpamSieve would crash when reading a damaged corpus file.

Worked around OS bug that could cause crashes when creating the Uncertain Junk
category in Entourage.

Notification dismissal now works on Tiger.

Apple Mail’s scripts are now installed in the correct location when running on Tiger.

2.2.3—November 15, 2004

Fixed bug where SpamSieve would complain of a permissions error at startup.

2.2.2—November 14, 2004

Can Notify with Growl when good messages arrive, and to help spot false positives
without looking through the entire contents of the spam folder.

Added Change Settings commands for Apple Mail and Entourage, which let you
configure script options (spam folder name, behavior when using Train Good and
Train Spam, etc.) without having to edit the scripts. The settings are stored in
SpamSieve’s preferences file, so they will persist if you update or re-install the scripts.

Fixed bug where SpamSieve would report a syntax error when processing certain mes-
sages (typically in non-ASCII character sets).

Better accuracy due to improved header and body analysis.
Better accuracy due to smarter auto-creation of From (name) rules.

Auto-training now takes scores into account; the corpus is updated using messages that
were harder to classify, to forestall errors.

Better handling of spam messages that lie about their encoding.

Entourage now uses two separate categories for spam messages, so that you can see
which ones are more (or less) spammy.

Improved accuracy when processing messages in German.
Any Address rules now match SendTo addresses.
Better handling of messages with “From ” lines.

Worked around Mail performance problem where Add Good would hang if there were
a lot of recipients.

The Dock (and DragThing) good message counter no longer increases for messages re-
ceived while the mail program is active.

Added Russian localization.
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e Improved the French localization.

e Better recovery from damaged Rules and History.db files.
e Added Italian-localized installation instructions.

e Improved launch time.

e Better parsing of PGP messages.

e Worked around 10.2 bug that could cause crashes when the Training Tip window was
updated.

e Fixed bad interaction between auto-training and duplicates when the corpus was small.
e More tolerant of incorrect file and folder permissions.

e If Launch Services cannot find the Eudora application, the installer will now try some
heuristics and prompt the user to locate Eudora, rather than giving up.

e The Apple Mail and Eudora plug-ins are better at finding and launching the SpamSieve
application, and they will notify the user if they are unable to do this.

e Updated to eSellerate 3.5.9, which provides support for registration names using non-
ASCII characters.

e When you type in your serial number, SpamSieve normalizes its spacing and case.

e The Add Good and Add Spam AppleScripts have been renamed Train Good and Train
Spam. When installing the new scripts, SpamSieve will automatically move the old ones
to the trash.

e The Entourage spam folder is now called Junk E-mail instead of Spam, since En-
tourage 2004 already has a so-named folder.
2.2.1—September 20, 2004
e Shows count of new good messages in DragThing?? 5.3 and later, if you install an inte-
gration script. (This script will be built into future versions of DragThing.)
e Fixed accuracy regressions from 2.1.4 and made some accuracy improvements.
e Added Italian localization.

e Auto-training will no longer add duplicate messages to the corpus, because they interfere
with undo.

e You can now start a new paragraph in the crash reporter by pressing Return rather than
Command-Return.

e Tries to add itself to the Launch Services database at launch, to make it easier for the
scripts and plug-ins to find the SpamSieve application.

e Fixed bug where the help buttons in the Preferences window didn’t work unless the
main help had previously been opened.

e Improved the French and Japanese localizations.

e The Edit Log command will now open the log using an editor, rather than Console, if
BBEdit is unavailable.

e Improved accuracy statistics when using Apple Mail IMAP accounts.

“nttp://www.dragthing. com
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e The mailbox parser is faster and more tolerant of malformed mbox files.
e No longer tries to roll over the log more than once per day.

e Fixed regression where adding to the whitelist or blocklist didn’t work if a disabled rule
matched the message.

e Fixed crash that could happen when showing progress bar at launch.
e Fixed crash when scanning System 7—format sounds.

e Fixed bug where slightly spammy Apple Mail messages would be colored and recorded
as spam, but not moved to the Spam mailbox.

2.2—August 24, 2004

e Accuracy Improvements

— SpamSieve is smarter about what text to tokenize, it extracts more information
from messages, it’s better at detecting invisible text, and it can undo more spammer
obfuscations.

— The Bayesian classifier can leverage the results of SpamAssassin’s heuristic tests. It
also assigns better word probabilities and is better at deciding which parts of the
message are important.

— Messages containing Habeas headers are now checked against the Habeas Whitelist3.
This protects against spam messages that include Habeas headers in order to get
through filters.

— Removed the Import Seed Spam command, as it would reduce accuracy with
recent versions of SpamSieve.

e General Improvements

— Auto-training is more automatic. There is now a single checkbox to enable auto-
training and, if it’s on, SpamSieve will try to do the right thing when it processes
new messages. That is, it will train itself using messages of the types that it needs
to see more of, and it will prevent the corpus from growing unbalanced or overly
large. Also, it will update the whitelist using every incoming good message, so that
you can have a complete whitelist without bloating the corpus.

— The rules and corpus windows now have toolbars, and they support iTunes-style
filter-searching.

— The corpus and rules are now scriptable**, and SpamSieve now supports Apple-
ScriptKit terminology.

— Assorted performance enhancements make SpamSieve faster and improve the re-
sponsiveness of its user interface.

— Added Portuguese localization.

e Blocklist and Whitelist

— Rules support more match fields: From (name), Any Recipient, Any Address,
Any Character Set, and Any Attachment Name.

— The new Import Addresses. .. command lets you import blocklist and whitelist rules
from text files (e.g. address book exports or mbox files).

“http://www.habeas . com/supportWhiteList.html
4nttp://c-command.com/scripts/spamsieve/
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Added default blocklist rules for .pif and .scr attachments and a default whitelist
rule for 1lists.c-command. com.

Rules can now match the empty string, e.g. when there is a subject header, but
the subject is blank. They can also match absent headers by matching against, e.g.
<SpamSieve-Unknown-Subject>.

The Text to Match field now abbreviates using an ellipsis if the text won’t all fit.

e Notification

Can make a Griffin PowerMate*® flash when new good messages arrive.

Now supports System 7—format notification sounds as well as Entourage sound
sets?6. In addition to the Library/Sounds folders, SpamSieve will now look for
sounds installed with Apple Mail, Entourage, Mailsmith, and PowerMail.

Doesn’t play the notification sound if you are using fast user switching and Spam-
Sieve is running in one of the background sessions.

Notifications that require dismissal (continuous bouncing, PowerMate flashing) are
no longer triggered when SpamSieve or the mail program is already frontmost. Thus,
you don’t have to deactivate the mail program and then activate it again to dismiss
the notification.

e Apple Mail Integration

Sets the colors of spam messages to reflect how spammy they are, making it easier
to skim the Spam mailbox for false positives.

Protects against Web bugs by telling Mail not to load the images from messages
that are classified as spam.

The Add Good script is better at moving messages from the Spam folder back to
the correct inbox, and it will mark them as unread when it does so.

The Add Good and Add Spam now work with Mac OS X 10.3.5.

The plug-in will look for SpamSieve in the Applications folder, even if Launch
Services is confused and says it can’t find it.

e Entourage Integration

The Exclude my addresses switch now also applies to the Entourage address book,
to reduce the chances of a forged spam getting through.

Added new scripting verb add entourage addresses. This will allow you to keep
the Entourage addresses in sync?” by using an Entourage shutdown schedule.

Can automatically add the recipients*® of the messages you send to the whitelist.
Sanity-checks addresses that are loaded from Entourage. For instance, if both the
name and the address were entered in Entourage’s address field, SpamSieve will now
extract just the address, rather than taking Entourage’s word for it.

The Add Good script now works with the Possible Spam®® folder and marks false
positives as unread.

Phttp://www.griffintechnology.com/products/powermate/
“http://www.soundsetcentral . com
4Thttp://c-command.com/scripts/spamsieve/entourage-load-addresses
“®nttp://c-command. com/scripts/spamsieve/entourage-whitelist-recipients
“nttp://c-command. com/scripts/spamsieve/entourage-separate-by-score
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Messages can have more than one category, so SpamSieve now adds and removes the
Junk category from the message, rather than replacing the category. This means
that marking a message as junk doesn’t wipe out other categories on the message.

Shows a progress bar while importing Entourage addresses.

Fudora Integration

Removed the option to use the full Fudora junk score range; this setting is now
always in effect.

Mailsmith Integration

Can automatically add the recipients®® of the messages you send to the whitelist.

PowerMail Integration

Can automatically add the recipients® of the messages you send to the whitelist.

Statistics and Log

The Statistics window shows the number of blocklist and whitelist rules and the
number of spam messages received per day. The date sheet has a Now button that
enters the current date and time.

The log is now stored in ~/Library/Logs/SpamSieve. The Open Log command
now opens the log in Console, so that it’s easier to monitor as it changes. To get
the old behavior of opening the log in a text editor, hold down Option and choose
Edit Log.

If the log file grows larger than 5 MB, SpamSieve compresses it, archives it by date,
and starts a new log.

When SpamSieve makes a mistake, the log records which classifier made the error
and what the message’s score was. The log also now records parse errors and the
number of messages in the corpus.

e Fixes and Tweaks

SpamSieve can optionally show an alternate, more photo-realistic, icon in the Dock.
There is a new mailing list®® for discussion of SpamSieve.

Each tab of the Preferences window now contains a help button that will open the
corresponding section of the Apple help.

Updated to PCRE 4.5 and SQLite 2.8.15.

Fixed bug where SpamSieve could crash when generating a messages’s identifier if
a system routine failed.

Fixed bug in EDMessage that could cause crashes when decoding certain quoted-
printable messages.

Better handling of 8-bit subjects with no specified encoding.

Worked around Panther bug that could cause crashes or drawing artifacts on the
desktop by no longer trying to draw on the Dock icon when it’s hidden.

Worked around OS bug that prevented certain notification sounds from playing.

Fixed bug where the selection was not always preserved when editing blocklist and
whitelist rules.

5Onttp://c-command.com/scripts/spamsieve/mailsmith-whitelist-recipients
5http://c-command. com/scripts/spamsieve/powermail-whitelist-recipients
52nttp://1lists.c-command.com/listinfo.cgi/spamsieve—talk—-c-command.com
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— The Show Corpus, Show Statistics, and Preferences. .. commands in the Dock
menu now bring SpamSieve to the front.

— The progress window when exporting the corpus sometimes lagged a bit before
closing automatically.

— Fixed bug where SpamSieve would get confused if you entered the empty string as
a date.

2.1.4—April 15, 2004

Fixed bug where SpamSieve could crash when installing the Eudora plug-in if you were
using Eudora 6.0.x.

Fixed regression where SpamSieve couldn’t process certain messages, resulting in a script
error and reduced accuracy.

Added French localization.
Updated AOL instructions, since AOL now supports IMAP.

2.1.3—April 13, 2004

Added menu commands for installing the Apple Mail plug-in and scripts, the Eudora
plug-in, and the Entourage scripts. These items are now stored inside the SpamSieve
application package.

Scripts for the other applications are now stored inside the application bundle, not at
the root of the disk image. The Show Other Scripts menu command will reveal them
in the Finder.

Apple Mail and Eudora users should update their plug-ins, using the commands in the
SpamSieve menu.

Added the score script command, which returns an integer between 0 and 100 indicating
how spammy the message is. 50 and higher mean spam.

The Predicted lines in SpamSieve’s log now show the scores of the messages.

Can now use Eudora’s full 0-to-100 junk score range if you check the appropriate box in
the Advanced preferences.

Improved parsing of messages with 8-bit transfer data.
Faster at processing messages.
Added support for Outlook Express 5.

Worked around OS bug that could cause SpamSieve to come to the front each time
a message was processed in Apple Mail or Eudora (usually if an X11 application was
frontmost).

Fixed bug where errors encountered while processing messages were not reported in the
log.

Worked around Cocoa problem where certain notification sounds wouldn’t play.

Made the Purchase window easier to understand, and added a button for looking up
lost serial numbers.

Trims the text in the serial number field so people don’t accidentally paste the number
in twice.
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Software updater is better at checking whether the computer can connect to the Internet.

SpamSieve now tries to parse Eudora messages according to RFC822, even though this
will sometimes fail, as many Eudora messages are not RFC822-compliant.

Adjusted the list of headers that SpamSieve ignores.
Added keyboard shortcuts for Apple Mail scripts.
Improved the training tips.

Updated to SQLite 2.8.13.

Updated to eSellerate SDK 3.5.5.

The Send Report button in the crash reporter is no longer a default button, so there’s
no longer confusion about entering returns in the comment field.

No longer prints fragments of spam messages to the console when it gets confused.

Replaced the copy of the manual outside the app with a read-me.

2.1.2—January 26, 2004

SpamSieve can now move Apple Mail POP messages to the Spam folder. Thus, it now
fully supports Apple Mail on Jaguar and Panther.

Honor Habeas headers is now off by default.

Fixed regression where blocklist and whitelist rules got deselected after editing their
text.

When loading addresses from Entourage, SpamSieve now picks up addresses that are
not associated with any contact (that is, they appear only in a group).

The default date shown in the Statistics window is now the date that SpamSieve was
first launched, rather than September 2002.

The Apple Mail Add Good script is better at finding the proper inbox when moving false
positives out of the Spam folder.

The Apple Mail Mark If Spam script can mark the spam messages as read.

The Purchase window now makes it more clear when a serial number has been accepted.
In the Statistics window, Set... is now Set Date... and Copy is now Copy Stats.
Fixed crash that could happen when processing messages in Japanese encodings.

Added Japanese localization.

2.1.1—January 8, 2004

Much faster at processing messages when there are many blocklist and whitelist rules.
Also improved the speed of loading, deleting, and sorting rules.

Improved accuracy tracking with the Panther version of Apple Mail; previously, Spam-
Sieve couldn’t always tell when it was being corrected.

Catches more spam because it knows about more spammer obfuscation tricks and also
which headers it should ignore.

Fixed bug (introduced in 2.0) where the Bayesian engine didn’t work if Mac OS X’s
default language was set to Japanese.
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The SpamSieve Eudora Plug-In is better at launching the SpamSieve application if it is
not already running.

Loading Entourage addresses now adds to the addresses that were previously loaded,
rather than replacing them. This makes it possible for Entourage users who have more
than one Entourage identity to give SpamSieve the addresses from all their address books
(by loading once for each identity). Hold down Option when clicking Load to get the
old behavior of replacing the previously loaded addresses.

The sound pop-up menu in the Preferences window now immediately notices when
new sounds are installed; previously, it would only check when updating the rest of the
preferences window.

You can now add a rule without a the Blocklist or Whitelist window being frontmost.
SpamSieve will ask which type of rule to add.

Regex rules can now start with an options modifier such as (?7-1i).

Copying rules to the clipboard now just copies the text to match (typically an e-mail
address), not all the columns. To get all the columns, you can print to PDF.

The Entourage Add Good script now finds localized inboxes, rather than creating a folder
called Inbox.

The Entourage Add Spam script can now remove spam messages from the server.

The Statistics window now shows percentages instead of ratios.

SpamSieve will now quit at launch if another copy of the application is already running.
Re-targeted broken Habeas URL.

Added the following menu commands: Close All Windows, Minimize All Windows,
and Zoom.

2.1—December 9, 2003

Added support for Apple Mail POP accounts. POP messages can be marked as junk
and colored, but (due to limitations in the present version of Apple Mail) they cannot
be moved to another mailbox.

Added a Training Tip window that gives advice on how to improve SpamSieve’s accu-
racy, based on the current state of the corpus and preferences.

Rules in the whitelist and blocklist are no longer limited to just matching sender ad-
dresses. They can now match a variety of message fields (To, CC, Subject, etc.), as
well as the message body. In addition to exact matches, rules now support the following
match styles: contains, starts with, ends with (useful for matching domains), and Perl-
compatible regular expressions. You can now edit rules and add new rules manually (as
opposed to automatically, as a result of training SpamSieve with a message).

When trained with a good message from a mailing list, SpamSieve will automatically
create a whitelist rule based on a mailing list header, if present.

SpamSieve can now read in the Entourage address book and use it as a whitelist. Thus,
the Entourage rule can now give SpamSieve all the messages, not just the ones that
were from unknown senders. This means that SpamSieve can now accurately notify the
user when non-spam messages are received. Also, the statistics it keeps will be more
complete.
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e Improved the accuracy of the Bayesian classifier when the corpus is unbalanced.

e Made a variety of low-level changes to improve SpamSieve’s accuracy, for instance: ad-
justed the list of headers that are analyzed and how words are tokenized.

e The Apple Mail Add Spam script now has an option to control whether the messages are
moved to the Spam folder.

e The Entourage Add Good script now moves messages to the inbox if they’re located in
the Spam folder.

e Mailsmith users can now auto-train using only spam or good messages by turning off
training in Mailsmith and turning on one of the auto-train checkboxes in SpamSieve.

e Improved the importing of mbox files that do not have blank lines between the messages,
such as some Eudora mailboxes. Fixed a bug where the the mbox parser could crash if
a message had length zero. Also, SpamSieve now shows a progress bar while counting
the number of messages that will be imported.

e Improved the corpus and rule list displays. You can now enter and leave editing mode
by typing Return. Type-ahead works better; for instance, if you type “g” and there are
no rows that start with “g,” it will look for one that starts with “f.” When you delete a
word or rule, you can cancel out of the confirmation sheet by typing Escape. To avoid
the confirmation sheet entirely, you can delete using Command-Delete instead of Delete.
When a word or rule is deleted, SpamSieve selects a nearby rule so that you don’t lose
your place. When deleting many words at once, SpamSieve no longer shows a progress
window for deletions that will not take very long.

e Entering the name and serial number to personalize SpamSieve is now more foolproof:
SpamSieve strips leading and trailing whitespace, and it detects when you enter a coupon
code in the serial number field. Fixed regression where SpamSieve rejected names con-
taining non-ASCII characters. In addition, there’s a new button for quickly redeeming
coupons.

e Updated to the latest eSellerate SDK so that purchasing SpamSieve from within the
application is faster.

e SpamSieve now requires Mac OS X 10.2.6 or later.

e Fixed bug where dates entered in the Statistics window were sometimes parsed in GMT
instead of the local time zone, thus causing the date to be off by a few hours.

e Improved the reliability and user interface of the crash reporter.

e No longer crashes when parsing certain non-RFC822-compliant Eudora messages.
2.0.2—October 1, 2003

e Now works with Apple Mail (IMAP and .Mac only, not POP).

e The message count in the Dock icon now resets when an e-mail client becomes active
(rather than just when SpamSieve became active). You can also control the size and
position of the number in the Dock icon.

e Much faster at deleting lots of rules at once.
e Replaced the message store database with custom code that’s faster and more reliable.

e Improved accuracy for HTML messages containing links.
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e Importing mbox files is faster.

e Fixed bug where you couldn’t use Web registration after the demo period had expired.
e The log records which addresses matched the whitelist or blocklist.

e The log records corpus imports.

e Auto-training is faster.

e The Entourage Add Spam script can close the frontmost window if it’s spam.

e Fixed bug where the date in the Statistics window could get cut off if you changed it
to use a more verbose format.

e Worked around OS bug that caused dates like “01.09.2003” to be interpreted as January
9 in German-style locales.

e Added Copy button to the Statistics window.

e Fixed problem updating certain history databases from 1.3.1.

e More resilient to minor corpus file corruption.

e Fixed crash that could happen with improperly formed multi-part messages.

e Shows the number of blocklist or whitelist rules in the title bar.

e The whitelist now contains some c-command.com addresses by default.

e Fixed crash when opening the Statistics window while adding messages.

e The Statistics window shows ratios, where applicable.

e Assorted minor performance improvements.

e The modification dates of the AppleScripts are now the actual modification dates, not
the date the distribution was built.

2.0.1—September 17, 2003

e Replaced the database engine that was being used to store the corpus with some custom
code. This should be much faster and more reliable.

e Loading and saving the rules is faster, due to a better file format.

e The rules and corpus message counts are now saved to disk during idle time rather than
when quitting. This should prevent data loss in the event that SpamSieve doesn’t quit
normally.

e The whitelist and blocklist are more memory-efficient.

e Plugged memory leak in EDMessage.

e Fixed crash involving certain really long header lines.

e Fixed bug where the Whitelist and Blocklist windows weren’t always up to date.

e Table views are smarter about not scrolling unnecessarily to maintain their selections.
e The Whitelist and Blocklist windows now secondary sort by sender.

e Changes to the preferences are saved to disk immediately.

e Fixed bug where tables saved their sorted columns but didn’t restore them.

e When SpamSieve gets a fatal error, it now quits like it says it will.

2.0—September 10, 2003
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SpamSieve now extracts a lot more information from each message. This makes it much
more accurate and also makes it learn faster.

Now integrates with Eudora 6 (Sponsored or Paid) via a plug-in. It can now process
every incoming Eudora message and can be trained using the Junk and Not Junk
commands in Eudora’s Message menu.

SpamSieve now has a blocklist and a whitelist. These are automatically maintained
based on the senders of messages that SpamSieve is trained with. The blocklist makes
sure that all messages from known spammers are caught and speeds processing for these
messages. The whitelist lets you be sure that certain messages will never be marked as
spam; this was possible before, but now you don’t have to clutter your address book
with addresses from online retailers, etc.

You can now control how conservative or aggressive SpamSieve is at catching spam.

SpamSieve can now play a sound or bounce its Dock icon after a batch of non-spam
messages has arrived. This is meant to replace your e-mail client’s new mail notification,
which you don’t want going off if all the new messages are spam.

Shows the number of new good messages in the Dock icon.

Now parses HTML so that it can better extract relevant information from HTML mes-
sages, and also handle various HTML-based tricks that spammers use to fool filters.

New method of calculating word probabilities makes SpamSieve better at discerning
which words in the message are important.

Includes a corpus of seed spam, to jump-start spam recognition for users who do not
have many saved spam messages.

The corpus is now stored in databases rather than in a property list. This makes it
launch faster and use much less memory, as the corpus doesn’t have to be all in RAM
at the same time.

The statistics file format (for History.db) has changed in order to enable performance
improvements and more statistical displays in future versions.

Handles more types of plain text obfuscations, and is much faster at undoing them.

Added option for the address book whitelist to only use other people’s addresses, so that
spam messages from your own address don’t match the whitelist.

Can mark all messages with Habeas headers as good.

Can mark all messages with some variant of “ADV” at the start of the subject as spam.
Can mark all base64-encoded HTML messages as spam.

New probability combiner increases accuracy.

Uses stop words to speed processing and reduce false negatives.

When filtering a message, considers the number of occurrences of the words, not just
which words are present.

Can import messages from mbox files.

Can import the corpus from and export it to an XML property list (the same format
used by 1.x).

SpamSieve can now check for updated versions of itself.
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Added crash reporter.

Added Dock menu containing frequently used commands.

The entries in the log are more detailed.

The corpus now stores the date at which each word was last accessed.

Fixed bug where storing statistics would fail on systems that didn’t know about GMT.

Fixed bug where SpamSieve could throw away long runs of HTML thinking they were
attachments.

Added button for opening the Mac OS X Address Book from inside SpamSieve.

The Statistics window now has a contextual menu item for copying the displayed in-
formation.

SpamSieve no longer wastes cycles updating the Statistics window after it’s been closed.

The Statistics window is smarter about updating only the portions that could have
changed.

No longer shows Good Words and Spam Words stats.

Logging has less overhead.

Updates the history asynchronously, resulting in faster message processing.
Checks for mistakes in a background thread.

False negatives are now written to disk in a background thread.
Re-arranged the Corpus window.

Pruning the corpus now works by access date rather than by word counts. Of course,
you can manually prune the old way by sorting the Corpus window by Total.

Updated to SQLite 2.8.6 and tuned it for speed.
Updated to PCRE 4.3.

Updated to eSellerate 3.5, which should fix crashes some people saw after registering on
10.2.6.

Now looks at headers of subparts of messages from Mailsmith.
Time-consuming operations now either have a progress bar or a progress spinner.
Better at extracting malformed e-mail addresses from headers.

Copying rows from the Corpus window to the clipboard now uses the order of the
columns in the window rather than the default column order.

Fixed regression where the Entourage scripts no longer created the Spam folder if it
didn’t exist.

Fixed potential crash with regex replacements at the end of a string.
History.db and the corpus can now be aliases.

Automatically trims carriage returns and other illegal characters when you paste in your
name and serial number.

Now saves the name and serial number to disk as soon as they’re entered.
The Spam folder in Entourage no longer has to be top-level.

Entourage can mark good messages as unread.
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Type-selecting in table views is quicker.
No longer nags constantly when unregistered.

Fixed bug where it could look as though SpamSieve had hung if it started up in the
background with an empty corpus.

1.3.1—June 18, 2003

Added direct integration with Mailsmith 2.0 and later. Enabling SpamSieve is as easy as
clicking a checkbox. You can train SpamSieve directly from Mailsmith’s Message menu.
Bare Bones Software has seamlessly integrated it with Mailsmith’s powerful filtering
system, and Mailsmith knows not to bounce its Dock icon after receiving a batch of
messages that are all spam.

Fixed crashing bug triggered by incorrectly encoded headers.
Regex substitutions are faster and much more memory efficient.

When adding spam messages to the corpus, the default is now for SpamSieve to move
them to the Spam folder.

The PowerMail Move If Spam script now changes the color of spam messages.

The Emailer scripts now pass text and HTML attachments on to SpamSieve for analysis.
Added instructions for using the Entourage and PowerMail address books as whitelists.
Compacted the ED frameworks to reduce application size and memory use.

Disabled SQLite’s file locking so that SpamSieve’s data folder can now be located on an
AppleShare volume.

Caches the Address Book to speed whitelist lookups 100 fold.
The statistics database is faster due to an updated version of SQLite.

Fixed bad pointer in header extractor that caused unnecessary fallbacks to the secondary
parser (reducing accuracy).

Added experimental support for moving Entourage messages on IMAP accounts to the
(local) Spam folder. This can be enabled by editing the scripts with Script Editor.

For clarity, the names of AppleScripts that ask SpamSieve to predict the category of a
message now contain the word “if.”

Added lots of minor clarifications to the documentation.

1.3—February 11, 2003

More resilient to spammers’ tricks for obfuscating words.

Can use e-mail addresses in the system Address Book as a whitelist. Messages sent from
those addresses will never be marked as spam.

Greatly reduced overall memory usage as well as launch and quit times.
Can save false negatives to disk for later reporting to SpamSieve’s developer.

You can edit the spam and good counts associated with a word, remove selected words
from the corpus, and reset the corpus entirely.

Type-ahead navigation in the Corpus window. Type the first few letters of a word or
number to select it (and scroll to it).
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You can hide statistics from before a set date, to better see the current accuracy and
spam reception rate.

Improvements to the Corpus window: Shows all words rather than only those considered
statistically significant. Re-sorting by numeric columns is twice as fast. You can copy
the selected rows to the clipboard or drag them to another application. The selection is
preserved when you change the sort column, you can sort in descending order, and the
sorted column is remembered between launches. The Home and End keys work.

The Prune Corpus command now tells you how many words it would remove and asks
for confirmation.

The statistics tracking is smarter about handling duplicate messages.

The statistics have tooltips explaining what they mean, and you can copy all of the
statistics to the clipboard at once.

Improved accuracy tracking of PowerMail and Emailer messages.

Eudora Integration: Can mark spam messages as read and/or mark them for removal
from the server.

Expanded the AppleScript dictionary, to enable better integration with mail and news
clients.

Entourage Integration: Creates Junk category if there isn’t one, and can mark spam
messages as read.

Mailsmith Integration: The adding scripts now set the appropriate message properties.
Better parsing of messages with illegal characters in the headers.

SpamSieve’s Info.plist file contains an LSUIElement entry. Change the 0 to a 1 to hide
the application’s Dock icon. (You’ll need to change it back to access the preferences.)

The message count display has moved from the Corpus window to the Statistics win-
dow.

Better error message when the corpus couldn’t be saved.

Added tooltips to preferences.

The registration window gives better feedback when you personalize.
Better recovery from errors in the corpus file.

The secondary parser is better at handling DOS linebreaks.

1.2.2—November 20, 2002

Fixed bug in the PowerMail Add Good script.

Added uninstaller for Eudora users.

Better handling of errors while adding messages to the corpus.
Removed bloat from the Entourage Mark Spam script.

The application icon now has an alpha channel, so it doesn’t appear with a white halo
when viewed on a colored background.

Minor changes to the manual.

1.2.1—November 18, 2002

72



Modified Info.plist to work around a bug in Mac OS X 10.1 that could cause the Finder
to crash when launching SpamSieve.

1.2—November 18, 2002

Added support for Emailer 2.0v3 and Eudora (5.2 and later).

Decodes base64 and quoted-printable text parts, thus finding words that spammers try
to hide from anti-spam software.

Decodes subjects that use different character sets (e.g. bigh).

Adds special tokens for MIME entities such as part boundaries and uninterpretable
message parts.

Keeps track of the messages added to the corpus, and can optionally prevent you from
adding the same message more than once (biasing the counts). Thus, you no longer have
to remember which messages you’ve already added.

You can now “undo” adds to the corpus, e.g. if you added a message as good when you
meant to add it as spam.

Can now add messages to the corpus as they are filtered, so after the initial training you
only have to add messages when SpamSieve makes a mistake.

When filtering a message, SpamSieve can optionally check whether the message is in
the corpus. If it is, SpamSieve looks up the answer rather than trying to predict. One
use of this feature is that if SpamSieve makes a mistake, you can Add Spam and then
Label/Move If Spam and be sure that the message will be labeled /moved.

Keeps a log of additions to the corpus, filtering results, and errors.

Mailsmith: If SpamSieve thinks a message is spam, it sets the deleted property of the
message to true; otherwise it sets the flagged property of the message to true. Therefore,
if SpamSieve has classified the message then exactly one of the properties will be true,
and if it hasn’t they’ll both be false. (Normally, neither of these message properties is
used by Mailsmith itself.)

Entourage and PowerMail: If you tell SpamSieve to move spam messages to a spam
folder and the spam folder doesn’t exist, the script will create the spam folder for you.

When you add spam messages to the corpus, can optionally move them to a Spam
folder.

Added status indicators in the Dock icon (like Norton DiskLight).
The spam probability of unknown words is now 0.4 instead of 0.2.
The Corpus window uses less memory and sorts much faster.
Accuracy tracking is faster and uses less memory and disk space.

Fixed bug where accuracy tracking didn’t work for some Mailsmith messages with mul-
tiple parts.

Improved the manual’s instructions for e-mail client integration.
Compiled with GCC 3 for greater speed.

Uses the latest version of the eSellerate SDK, which eliminates a crash at startup under
certain circumstances.
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e No longer shows the “Upgrading From 1.0” message when starting with a blank corpus.
1.1—September 19, 2002

e E-Mail Client Integration

— Added support for PowerMail.

— Added instructions and an AppleScript for making Mailsmith download and filter
mail faster.

— Added an AppleScript for Entourage that moves spam into a Junk folder.
e Performance

— Launches about 60% faster than 1.0.

— You can now prune the corpus to remove words that are taking up memory without
contributing to spam recognition. This can also dramatically decrease SpamSieve’s
launch time.

— Recalculating spam probabilities is about 10% faster and uses less memory.

— Quitting is faster because SpamSieve now writes corpus changes to disk during idle
time.

— Saving the corpus is slightly faster.

e Displays statistics about the number of messages filtered, SpamSieve’s accuracy, and the
types of words in the corpus.

e SpamAssassin’s X-Spam-Status headers are now treated as single words. This means
that if SpamAssassin is running on your mail server, SpamSieve will learn to respect (or
ignore) its judgment.

e Does a better job of ignoring e-mail attachments, thus reducing corpus bloat.

e Installs the eSellerate Engine if it’s not present, thus enabling “Instant Registration” for
more users.

e Asking SpamSieve to categorize a message now forces an update of all the word proba-
bilities. Previously, the update only happened during idle time.

e Highlights the sorted column in the Corpus window. The columns themselves have
shorter names. There’s a new “Total” column. Auto-resizing of the columns works
better. You can now manually resize any column, and manual resizings and reorderings
are saved between launches.

e Shows fatal errors as alert panels rather than just printing them on the console.

e The Corpus.plist data file is now sorted by word. This makes it easier to examine the
corpus manually, and to compare it to other users’ corpora.

1.0—September 10, 2002

e First public release.
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